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About the SpeakerAbout the Speaker
19821982--1992: VMS operating systems development at Digital1992: VMS operating systems development at Digital
19921992--present: Researching, writing, and teaching Windows present: Researching, writing, and teaching Windows 
operating system internalsoperating system internals
Frequent speaker at technical conferencesFrequent speaker at technical conferences
(Microsoft (Microsoft TechEdTechEd, IT Forum, , IT Forum, PDCsPDCs, , ……))
Books:Books:

Windows Internals, 4Windows Internals, 4thth editionedition
Inside Windows 2000, 3Inside Windows 2000, 3rdrd editionedition
Inside Windows NT, 2nd editionInside Windows NT, 2nd edition
Windows NT for OpenVMS ProfessionalsWindows NT for OpenVMS Professionals

Video Training:Video Training:
Interactive Windows 2000/XP/2003 internalsInteractive Windows 2000/XP/2003 internals
tutorialtutorial
Used by Microsoft for their internal trainingUsed by Microsoft for their internal training

Live Classes:Live Classes:
22--5 day classes5 day classes on on Windows Internals,Windows Internals,
Advanced TroubleshootingAdvanced Troubleshooting
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Purpose of TutorialPurpose of Tutorial
Give IT Professionals a foundation understanding of the Give IT Professionals a foundation understanding of the 
Windows OS kernel architectureWindows OS kernel architecture

Note: this is a small, but important part of WindowsNote: this is a small, but important part of Windows
The The ““plumbing in the boiler roomplumbing in the boiler room””

Condensed from a 5 day internals classCondensed from a 5 day internals class

Benefits:Benefits:
Able to troubleshoot problems more effectivelyAble to troubleshoot problems more effectively
Understand system performance issuesUnderstand system performance issues

Applies to NT4, Windows 2000, Windows XP, and Applies to NT4, Windows 2000, Windows XP, and 
Windows Server 2003Windows Server 2003
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OutlineOutline
1.1. Process & Thread TroubleshootingProcess & Thread Troubleshooting

2.2. Understanding & Troubleshooting Memory Understanding & Troubleshooting Memory 
ProblemsProblems

3.3. Troubleshooting with Troubleshooting with FilemonFilemon & & RegmonRegmon

4.4. Crash Dump AnalysisCrash Dump Analysis

5.5. Boot & Startup TroubleshootingBoot & Startup Troubleshooting
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Part 1: Process & Thread Part 1: Process & Thread 
TroubleshootingTroubleshooting

IntroductionIntroduction

Investigating Processes & ThreadsInvestigating Processes & Threads

Accounting for CPU UsageAccounting for CPU Usage

Process Handle TableProcess Handle Table

DLLs and Memory Mapped FilesDLLs and Memory Mapped Files

Investigating Unknown ProcessesInvestigating Unknown Processes
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Analyzing CPU ActivityAnalyzing CPU Activity

Scenario: your system is Scenario: your system is 
slowslow

What is running and why?What is running and why?

What do you do?What do you do?
Most bring up Task Most bring up Task 
Manager, which by default Manager, which by default 
lists the lists the ““running running 
applicationsapplications””

This doesnThis doesn’’t tell you t tell you 
anythinganything
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Which Process Is Consuming CPU?Which Process Is Consuming CPU?

The Processes tab The Processes tab doesdoes indicate indicate 
what is using the CPU (sort of)what is using the CPU (sort of)

Note that CPU Time column is Note that CPU Time column is 
mostly 0 (explained later)mostly 0 (explained later)

To determine which process is To determine which process is 
consuming the most CPU time, sort consuming the most CPU time, sort 
processes by processes by ““CPUCPU”” usage columnusage column
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Processes And ThreadsProcesses And Threads

What is a process?What is a process?
Represents an instance of a running programRepresents an instance of a running program

You create a process to run a programYou create a process to run a program
Starting an application creates a processStarting an application creates a process

Process defined byProcess defined by
Address spaceAddress space
Resources (e.g., open handles)Resources (e.g., open handles)
Security profile (token)Security profile (token)

What is a thread?What is a thread?
An execution context within a processAn execution context within a process
Unit of scheduling (threads run, processes donUnit of scheduling (threads run, processes don’’t t 
run)run)
All threads in a process share the same perAll threads in a process share the same per--
process address spaceprocess address space

Services provided so that threads can Services provided so that threads can 
synchronize access to shared resources (critical synchronize access to shared resources (critical 
sections, sections, mutexesmutexes, events, semaphores), events, semaphores)

All threads in the system are scheduled as All threads in the system are scheduled as 
peers to all others, without regard to their peers to all others, without regard to their 
““parentparent”” processprocess

PerPer--processprocess
address spaceaddress space

SystemSystem--wide wide 
Address SpaceAddress Space

ThreadThread

ThreadThread

ThreadThread
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What Are Task ManagerWhat Are Task Manager’’s s ““ApplicationsApplications””??

A meaningless term at the OS levelA meaningless term at the OS level
Not a list of processesNot a list of processes

Not a list of Not a list of ““taskstasks”” (another (another 
meaningless term)meaningless term)

ItIt’’s a list of top level visible windows in s a list of top level visible windows in 
your session that meet certain criteriayour session that meet certain criteria

What does the status column mean?What does the status column mean?
Running:Running:

Windows donWindows don’’t runt run——threads dothreads do

Running displayed only when Running displayed only when 
owning thread is waiting for a owning thread is waiting for a 
window message (e.g. not running!)window message (e.g. not running!)

Not Responding: not waiting for window Not Responding: not waiting for window 
messagesmessages

To map a window to a process, rightTo map a window to a process, right--
click on a window and select click on a window and select ““Go to Go to 
processprocess””
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Identify The ImageIdentify The Image

Once youOnce you’’ve found the process of interest, what is ve found the process of interest, what is 
it?it?

Sometimes name of .EXE identifies clearly Sometimes name of .EXE identifies clearly 
(e.g., (e.g., Winword.exeWinword.exe))

Often, it doesnOften, it doesn’’t since Task Manager doesnt since Task Manager doesn’’t show the t show the 
full path of the imagefull path of the image

Sometimes is a Sometimes is a ““multimulti--purposepurpose”” process like process like 
Svchost.exeSvchost.exe or or Inetinfo.exeInetinfo.exe or or Dllhost.exeDllhost.exe or Systemor System

We need more information! We need more information! 



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

1-11

Process ExplorerProcess Explorer
““Super Task ManagerSuper Task Manager””

Illuminates many details about processes and Illuminates many details about processes and 
threads that are otherwise hard or impossible to threads that are otherwise hard or impossible to 
obtainobtain
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How Process Explorer WorksHow Process Explorer Works

Uses undocumented functions for:Uses undocumented functions for:
Enumerating loaded modules with full Enumerating loaded modules with full 
path namespath names

Enumerating processes and handlesEnumerating processes and handles

Obtains handle names using the aid Obtains handle names using the aid 
of a driverof a driver

Runs on Win95, 98, ME, NT4, 2000, XP, 2003Runs on Win95, 98, ME, NT4, 2000, XP, 2003

Related Tools:Related Tools:
Handle Handle –– commandcommand--line handle viewerline handle viewer

ListdllsListdlls –– commandcommand--line DLL viewerline DLL viewer
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AgendaAgenda

IntroductionIntroduction

Investigating Processes & ThreadsInvestigating Processes & Threads

Accounting for CPU UsageAccounting for CPU Usage

Process Handle TableProcess Handle Table

DLLs and Memory Mapped FilesDLLs and Memory Mapped Files

Investigating Unknown ProcessesInvestigating Unknown Processes
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Lab:  The Process ListLab:  The Process List

1.1. Run Process Explorer & maximize windowRun Process Explorer & maximize window
2.2. Run Task Manager Run Task Manager –– click on Processes tabclick on Processes tab
3.3. Arrange windows so you can see bothArrange windows so you can see both
4.4. Notice process tree Notice process tree vsvs flat list in Task Managerflat list in Task Manager

If parent has exited, process is left justifiedIf parent has exited, process is left justified

5.5. Sort on first column (Sort on first column (““ProcessProcess””) and note tree view ) and note tree view 
disappearsdisappears

6.6. Click on ViewClick on View-->Show Process Tree (or CTRL+T) to >Show Process Tree (or CTRL+T) to 
bring it backbring it back

7.7. Notice description and company name columnsNotice description and company name columns
8.8. Hover mouse over image to see full path of imageHover mouse over image to see full path of image
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Lab:  Refresh HighlightingLab:  Refresh Highlighting

1.1. Change update speed to paused by pressing space barChange update speed to paused by pressing space bar

2.2. Run NotepadRun Notepad

3.3. In In ProcExpProcExp, hit F5 and notice new process, hit F5 and notice new process

4.4. Exit NotepadExit Notepad

5.5. In In ProcExpProcExp, hit F5 and notice Notepad in red, hit F5 and notice Notepad in red

UsesUses
Understanding process startup sequencesUnderstanding process startup sequences

Detecting appearance of processes coming and goingDetecting appearance of processes coming and going
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Lab:  Column Selection And Lab:  Column Selection And 
UsernameUsername

1.1. Click on ViewClick on View-->Select Columns>Select Columns
Add username columnAdd username column

2.2. Compare username column in Task Manager Compare username column in Task Manager 
with Process Explorer with Process Explorer –– what is the difference?what is the difference?

3.3. Deselect ViewDeselect View-->Show Processes From All >Show Processes From All 
UsersUsers
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Lab: Image InformationLab: Image Information

Open Process PropertiesOpen Process Properties
Items of note on Image tabItems of note on Image tab

Description, company name, Description, company name, 
version (from .EXE)version (from .EXE)
Image verification statusImage verification status
Full image pathFull image path
Command line used to start Command line used to start 
processprocess
Current directoryCurrent directory
Parent processParent process
User nameUser name
Start timeStart time
Bring to FrontBring to Front

Useful if multiple windows with Useful if multiple windows with 
identical titlesidentical titles
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Lab: The Command LineLab: The Command Line

1.1. Double click on date/time in task bar (lower right Double click on date/time in task bar (lower right 
of screen)of screen)

2.2. In Process Explorer, hit F5 to refreshIn Process Explorer, hit F5 to refresh

3.3. Find new process created (RUNDLL32.EXE)Find new process created (RUNDLL32.EXE)

4.4. Examine command line argumentsExamine command line arguments

Example: Example: cmd.execmd.exe process was consuming lots process was consuming lots 
of CPU timeof CPU time

Command line argument showed which .BAT file Command line argument showed which .BAT file 
was runningwas running
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Associating Windows with ProcessesAssociating Windows with Processes
Task Manager can associate a window in its list with a Task Manager can associate a window in its list with a 
processprocess

But sometimes windows appear that are not in its But sometimes windows appear that are not in its 
““ApplicationsApplications”” listlist

Process Explorer has a Process Explorer has a ““window finderwindow finder”” tooltool
On tool bar, drag window finder icon over window and releaseOn tool bar, drag window finder icon over window and release

Process that owns thread that owns window is highlightedProcess that owns thread that owns window is highlighted

Visual Studio Spy++ tool shows which thread owns a Visual Studio Spy++ tool shows which thread owns a 
windowwindow……
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SecuritySecurity
Click on Security tab of Click on Security tab of 
process propertiesprocess properties

Shows rest of access token Shows rest of access token 
(username is on image tab)(username is on image tab)

Groups listGroups list
Includes OSIncludes OS--assigned groupsassigned groups

Privileges (user rights)Privileges (user rights)
Disabled by defaultDisabled by default

Programs turn these on when Programs turn these on when 
neededneeded

This is really a This is really a ““Resultant Set Resultant Set 
of Groupsof Groups”” and and ““Resultant Set Resultant Set 
of Privilegesof Privileges”” pagepage
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Lab: PrivilegesLab: Privileges

1.1. Bring up process properties for Bring up process properties for Explorer.exeExplorer.exe

2.2. Go to Security tab and notice that Go to Security tab and notice that 
SeSystemTimeSeSystemTime privilege is disabledprivilege is disabled

3.3. DoubleDouble--click on Date/Time in the trayclick on Date/Time in the tray

4.4. Bring up the process properties for the new Bring up the process properties for the new 
Rundll32.exe processRundll32.exe process

5.5. Click on the Security tabClick on the Security tab

6.6. Notice Notice SeSystemTimeSeSystemTime privilege is enabledprivilege is enabled
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.NET Processes.NET Processes

Process Explorer is aware Process Explorer is aware 
of .NET processesof .NET processes

Can highlight with OptionsCan highlight with Options--
>Highlight .NET Processes>Highlight .NET Processes

Process properties have Process properties have 
.NET tab.NET tab

Shows details about .NET Shows details about .NET 
process (CLR, process (CLR, AppdomainsAppdomains))

Can also add .NETCan also add .NET--specific specific 
columns to process listcolumns to process list



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

1-29

Service InformationService Information

Process Explorer identifies Service ProcessesProcess Explorer identifies Service Processes
Click on OptionsClick on Options-->Highlight Services>Highlight Services
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Examining Service ProcessesExamining Service Processes

Services tab on process Services tab on process 
properties lists the active properties lists the active 
services insideservices inside

Displays the internal name, Displays the internal name, 
the display name, and the display name, and 
description (if available)description (if available)

TlistTlist /s (Debugging Tools) & /s (Debugging Tools) & 
TasklistTasklist /svc (new as of XP) /svc (new as of XP) 
only show internal nameonly show internal name
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Lab: ServicesLab: Services

1.1. Open a command promptOpen a command prompt

2.2. Type Type ““tasklisttasklist /svc/svc””

3.3. Find the Find the Svchost.exeSvchost.exe process with the most process with the most 
services inside itservices inside it

4.4. In Process Explorer, double click on that In Process Explorer, double click on that 
Svchost.exeSvchost.exe processprocess

5.5. Click on Services tabClick on Services tab

6.6. Notice extra details about each service Notice extra details about each service 
displayed by Process Explorerdisplayed by Process Explorer
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AgendaAgenda

IntroductionIntroduction

Investigating Processes & ThreadsInvestigating Processes & Threads

Accounting for CPU UsageAccounting for CPU Usage

Process Handle TableProcess Handle Table

DLLs and Memory Mapped FilesDLLs and Memory Mapped Files

Investigating Unknown ProcessesInvestigating Unknown Processes
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Examining CPU TimeExamining CPU Time

Looking at total CPU time for each process may not reveal Looking at total CPU time for each process may not reveal 
where system has spent its timewhere system has spent its time

Task Manager rounds CPUTask Manager rounds CPU

In Process Explorer, click on OptionsIn Process Explorer, click on Options-->Show Fractional CPU time>Show Fractional CPU time
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Time AccountingTime Accounting

CPU time accounting is driven by programmable CPU time accounting is driven by programmable 
interrupt timerinterrupt timer

Normally 10 Normally 10 msecmsec

Run Run ClockresClockres (Sysinternals tool) to check(Sysinternals tool) to check

Thread execution and context switches between clock Thread execution and context switches between clock 
intervals NOT accountedintervals NOT accounted

E.g., one or more threads run and enter a wait state before E.g., one or more threads run and enter a wait state before 
clock firesclock fires

Thus threads run but never get chargedThus threads run but never get charged

Process Explorer can show context switch activityProcess Explorer can show context switch activity
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Context Switch DeltaContext Switch Delta

Whenever a thread begins running, its Whenever a thread begins running, its ““context context 
switchswitch”” counter incrementscounter increments

The number of context switches doesnThe number of context switches doesn’’t reflect length t reflect length 
of execution, just number of times it was scheduledof execution, just number of times it was scheduled

Process Explorer has a context switch delta Process Explorer has a context switch delta 
column column 

Sum of thread context switches in last refresh Sum of thread context switches in last refresh 
intervalinterval

Notice all of the thread activity in processes that Notice all of the thread activity in processes that 
show 0% CPUshow 0% CPU
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Interrupt Time AccountingInterrupt Time Accounting
Interrupt activity is not charged to any thread or process Interrupt activity is not charged to any thread or process 

Two types:  interrupts and Two types:  interrupts and DPCsDPCs

Task Manager includes interrupt and DPC time with the Idle Task Manager includes interrupt and DPC time with the Idle 
process timeprocess time

Process Explorer shows these as separate processes Process Explorer shows these as separate processes 
(not really processes)(not really processes)

Context switches for these are really number of interrupts and Context switches for these are really number of interrupts and 
DPCsDPCs
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Identifying ISR and Identifying ISR and DPCDPC’’ss by Driver by Driver 

Since time spent at DPC level and above is not accounted by drivSince time spent at DPC level and above is not accounted by driver er 
type, one way to determine where time has been spent in kernel type, one way to determine where time has been spent in kernel 
mode is by using a mode is by using a profiling/sampling profiling/sampling tooltool

KernrateKernrate is a such a toolis a such a tool
Free download from Free download from 
http://www.microsoft.com/http://www.microsoft.com/whdc/system/sysperf/krview.mspxwhdc/system/sysperf/krview.mspx

Can be used both for kernel time and user mode processesCan be used both for kernel time and user mode processes

Can show where time is being spent down to the function levelCan show where time is being spent down to the function level

May miss short lived events or events close to the sampling inteMay miss short lived events or events close to the sampling intervalrval

XP SP2 and Server 2003 SP1 and later support tracing XP SP2 and Server 2003 SP1 and later support tracing 
ISRsISRs and and DPCsDPCs

Documented in Windows InternalsDocumented in Windows Internals
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Understanding Understanding Svchost.exeSvchost.exe CPU Time CPU Time 
ConsumptionConsumption

If a If a SvchostSvchost or other multior other multi--component process component process 
such such Inetinfo.exeInetinfo.exe (IIS) or (IIS) or Dllhost.exeDllhost.exe (COM) is (COM) is 
consuming CPU time, how do you determine consuming CPU time, how do you determine 
which service is responsible?which service is responsible?

Need to drill down to thread granularityNeed to drill down to thread granularity

Two approaches:Two approaches:
Invasive: attach with a debugger to examine threadsInvasive: attach with a debugger to examine threads

Threads are suspended while lookingThreads are suspended while looking

Noninvasive: view threads with Process ExplorerNoninvasive: view threads with Process Explorer
Threads are not affected while lookingThreads are not affected while looking
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Viewing Threads with Process ExplorerViewing Threads with Process Explorer

Process Explorer Process Explorer 
““ThreadsThreads”” tab shows tab shows 
which which thread(sthread(s) are ) are 
runningrunning

Start address represents Start address represents 
where the thread began where the thread began 
running (not where it is running (not where it is 
now)now)

Click Module to get details Click Module to get details 
on module containing on module containing 
thread start addressthread start address
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Thread Start FunctionsThread Start Functions

Process Explorer can map the addresses within a Process Explorer can map the addresses within a 
module to the names of functionsmodule to the names of functions

This can help identify which component within a This can help identify which component within a 
process is responsible for CPU usageprocess is responsible for CPU usage

Requires access to:Requires access to:
Symbol file for that moduleSymbol file for that module

Proper version of Proper version of Dbghelp.dllDbghelp.dll
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Lab: ThreadsLab: Threads

Double click on the Double click on the SvchostSvchost process running process running 
under Local Service (if Win2000, pick any under Local Service (if Win2000, pick any 
SvchostSvchost))

Go to Threads tabGo to Threads tab

Find thread with the most number of context switchesFind thread with the most number of context switches

Look at the start address to determine which service Look at the start address to determine which service 
DLL itDLL it’’s runnings running
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Call StacksCall Stacks

Process Explorer can also show Process Explorer can also show 
the thread call stackthe thread call stack

Represents sequence of Represents sequence of 
functions calledfunctions called

Important if start address Important if start address 
doesndoesn’’t indicate what the thread t indicate what the thread 
is doingis doing

E.g. if itE.g. if it’’s a generic library start s a generic library start 
routineroutine

Function 2Function 2

Function 1Function 1

Function 3Function 3



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

1-44

Call StacksCall Stacks

Click Stack to view call stackClick Stack to view call stack
Lists functions in reverse Lists functions in reverse 
chronological orderchronological order

Note that start address on Note that start address on 
Threads tab is different than Threads tab is different than 
first function shown in stackfirst function shown in stack

This is because all threads This is because all threads 
created by Windows programs created by Windows programs 
start in a library function in start in a library function in 
Kernel32.dll which calls the Kernel32.dll which calls the 
programmed start addressprogrammed start address
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Example: Solving Hung ProcessesExample: Solving Hung Processes

Problem: Problem: PowerpointPowerpoint was hanging for 1 minute on was hanging for 1 minute on 
startupstartup

Thread stack shows waiting on a printer driverThread stack shows waiting on a printer driver
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Hung ProcessesHung Processes

If thread stack doesnIf thread stack doesn’’t solve it, get a memory t solve it, get a memory 
dump of the process address space and send to dump of the process address space and send to 
developerdeveloper

Use Use AdplusAdplus in Debugging Toolsin Debugging Tools
Can snapshot a group of processes at the same timeCan snapshot a group of processes at the same time

Can also run Drwtsn32.exeCan also run Drwtsn32.exe
Drwtsn32.exe    Drwtsn32.exe    --p   <p   <processidprocessid>>

Creates Creates User.dmpUser.dmp filefile

Run Drwtsn32.exe with no switches to see crash dump Run Drwtsn32.exe with no switches to see crash dump 
pathpath

Note: in XP and later, by default does not create a full Note: in XP and later, by default does not create a full 
dumpdump
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Understanding System Process CPU Understanding System Process CPU 
Time ConsumptionTime Consumption

The The ““SystemSystem”” process is another process is another ““multimulti--service processservice process””
Windows NT 4.0:  PID 2, Windows 2000:  PID 8, Windows XP:  Windows NT 4.0:  PID 2, Windows 2000:  PID 8, Windows XP:  
PID 4PID 4

Contains kernelContains kernel--mode system threadsmode system threads
Functions in OS and some drivers that need to run as real Functions in OS and some drivers that need to run as real 
threadsthreads

E.g., need to run concurrently with other system activity, wait E.g., need to run concurrently with other system activity, wait on on 
timers, perform background timers, perform background ““housekeepinghousekeeping”” workwork

System threads can be in other processesSystem threads can be in other processes
Look for threads with 100% kernel mode timeLook for threads with 100% kernel mode time
Example: CSRSS contains threads running pieces of Win32k.sysExample: CSRSS contains threads running pieces of Win32k.sys
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Examining System ThreadsExamining System Threads
If System threads are consuming CPU time, need to find If System threads are consuming CPU time, need to find 
out what code is running, since it could be any one of a out what code is running, since it could be any one of a 
variety of componentsvariety of components

Pieces of OS (Pieces of OS (Ntoskrnl.exeNtoskrnl.exe))

File server worker threads (File server worker threads (Srv.sysSrv.sys))

Other driversOther drivers
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Lab: System ThreadsLab: System Threads

1.1. Generate network file access activity, for Generate network file access activity, for 
example, example, ““dir dir \\\\computernamecomputername\\cc$ /s$ /s””
•• System process should be consuming CPU timeSystem process should be consuming CPU time

2.2. Open System process Open System process processprocess propertiesproperties

3.3. Go to Threads tabGo to Threads tab

4.4. Sort by CPU time and find Sort by CPU time and find thread(sthread(s) running) running

5.5. Determine what driver these are inDetermine what driver these are in
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AgendaAgenda

IntroductionIntroduction

Investigating Processes & ThreadsInvestigating Processes & Threads

Accounting for CPU UsageAccounting for CPU Usage

Process Handle TableProcess Handle Table

DLLs and Memory Mapped FilesDLLs and Memory Mapped Files

Investigating Unknown ProcessesInvestigating Unknown Processes
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Handle ViewHandle View

Each process has a list of open Each process has a list of open ““objectsobjects””
Files, Registry keys, synchronization objects, TCP/UDP portsFiles, Registry keys, synchronization objects, TCP/UDP ports……

May be useful to query this listMay be useful to query this list

Microsoft tools:Microsoft tools:
Oh.exeOh.exe in Resource Kitin Resource Kit

XP/2003 have new XP/2003 have new ““OpenfilesOpenfiles /query/query”” commandcommand
Only shows handles to open files Only shows handles to open files –– not other nonnot other non--file objectsfile objects

Both require setting a global flag and rebooting (see Both require setting a global flag and rebooting (see Gflags.exeGflags.exe
in Support Tools)in Support Tools)

Process Explorer can show open handles without this flagProcess Explorer can show open handles without this flag
Uses a device driverUses a device driver
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Uses Of Handle ViewUses Of Handle View

Understand resources used by an applicationUnderstand resources used by an application
FilesFiles

Registry keysRegistry keys

Note: by default, shows named objectsNote: by default, shows named objects
Click on OptionsClick on Options-->Show Unnamed Objects>Show Unnamed Objects

Solve file locked errorsSolve file locked errors
Use the search feature to determine what process is holding a Use the search feature to determine what process is holding a 
file or directory openfile or directory open

Can even close an open files (be careful!)Can even close an open files (be careful!)

View the state of synchronization objects (View the state of synchronization objects (mutexesmutexes, , 
semaphores, events)semaphores, events)

Detect handle leaks using refresh difference highlightingDetect handle leaks using refresh difference highlighting
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Lab: Handle Difference HighlightingLab: Handle Difference Highlighting

1.1. Open a command prompt (Open a command prompt (Cmd.exeCmd.exe))

2.2. Open Process Explorer and pause itOpen Process Explorer and pause it

3.3. View the commandView the command--promptprompt’’s handles in Process s handles in Process 
Explorer and identify the handle to the current directoryExplorer and identify the handle to the current directory

4.4. Change directories in the command promptChange directories in the command prompt

5.5. Refresh in Process Explorer to see the old directory Refresh in Process Explorer to see the old directory 
handle close and new one openhandle close and new one open
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AgendaAgenda

IntroductionIntroduction

The Process ViewThe Process View

Accounting for CPU UsageAccounting for CPU Usage

The Handle ViewThe Handle View

The DLL ViewThe DLL View

Investigating Unknown ProcessesInvestigating Unknown Processes

System InformationSystem Information
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DLL ViewDLL View

Click on ViewClick on View-->DLL View>DLL View
Shows more than just loaded DLLsShows more than just loaded DLLs

Includes .EXE and any Includes .EXE and any ““memory mapped filesmemory mapped files””
High speed file access mechanismHigh speed file access mechanism

Makes file appear as virtual memoryMakes file appear as virtual memory

Uses:Uses:
Detect DLL versioning problemsDetect DLL versioning problems

Compare the output from a working process with that of a Compare the output from a working process with that of a 
failing one (use Filefailing one (use File-->Save As)>Save As)

Find which processes are using a specific DLL Find which processes are using a specific DLL 
(search for it)(search for it)
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Access Denied On Mapped FilesAccess Denied On Mapped Files

Attempting to delete a DLL or EXE that is in use gets Attempting to delete a DLL or EXE that is in use gets 
““access deniedaccess denied””, not , not ““file lockedfile locked””

Can be misleadingCan be misleading

If this occurs, and itIf this occurs, and it’’s not due to permissions problems, s not due to permissions problems, 
simply search DLL list with Process Explorer for filesimply search DLL list with Process Explorer for file

LabLab
Run Run Notepad.exeNotepad.exe and then try to delete and then try to delete \\windowswindows\\notepad.exenotepad.exe

Do a search for Do a search for Notepad.exeNotepad.exe in DLL viewin DLL view
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AgendaAgenda

IntroductionIntroduction

Investigating Processes & ThreadsInvestigating Processes & Threads

Accounting for CPU UsageAccounting for CPU Usage

Process Handle TableProcess Handle Table

DLLs and Memory Mapped FilesDLLs and Memory Mapped Files

Investigating Unknown ProcessesInvestigating Unknown Processes
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Investigating Unknown ProcessesInvestigating Unknown Processes

Some processes have no identifiable informationSome processes have no identifiable information
No version information, are in the System32 No version information, are in the System32 
directory, etc.directory, etc.

Right clickRight click-->Google or MSN Search>Google or MSN Search

Check the parent processCheck the parent process

Look at the Handle table for file or Registry key Look at the Handle table for file or Registry key 
handleshandles
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Suspend it While You LookSuspend it While You Look

Process Explorer can suspend a processProcess Explorer can suspend a process
This suspends the threadsThis suspends the threads

Why would you want to do this?Why would you want to do this?
Gives you time to investigate possible Gives you time to investigate possible malwaremalware without having without having 
to kill it on sightto kill it on sight

Other applications:Other applications:
YouYou’’ve started a long running job but want to pause it to do ve started a long running job but want to pause it to do 
something elsesomething else

Lowering the priority still leaves it runningLowering the priority still leaves it running……
YouYou’’ve started a long download but want to have your network ve started a long download but want to have your network 
bandwidth temporarilybandwidth temporarily
Some multiSome multi--service system process activity is due to other service system process activity is due to other 
processes calling upon their servicesprocesses calling upon their services

Suspend a process that is consuming CPU time to see what that Suspend a process that is consuming CPU time to see what that 
does to the system process in questiondoes to the system process in question
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Examine Open TCP/IP EndpointsExamine Open TCP/IP Endpoints

Open connections might reveal Open connections might reveal spywarespyware

NetstatNetstat (part of XP) command lists all endpoints(part of XP) command lists all endpoints
TCPViewTCPView from Sysinternals also lists thisfrom Sysinternals also lists this

Or, use Process Explorer TCP/IP tabOr, use Process Explorer TCP/IP tab
Can display thread stack of thread that opened Can display thread stack of thread that opened 
endpointendpoint
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Image StringsImage Strings

Strings tab on process properties shows Strings tab on process properties shows 
printable Unicode and printable Unicode and AsciiAscii strings in .EXEstrings in .EXE

Might find clues from registry keys, URLs or error Might find clues from registry keys, URLs or error 
messagesmessages

Need also to check strings in loaded DLLsNeed also to check strings in loaded DLLs
Choose DLL view in Process ExplorerChoose DLL view in Process Explorer

Select DLL and right clickSelect DLL and right click-->Strings>Strings

Also can use command line Also can use command line Strings.exeStrings.exe tool tool 
from from SysinternalsSysinternals
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Understanding Who Started ProcessesUnderstanding Who Started Processes
New XP builtNew XP built--in in ““System ConfigurationSystem Configuration”” tool shows startup processestool shows startup processes

To run, click on StartTo run, click on Start-->Help, then >Help, then ““Use ToolsUse Tools…”…”, then System , then System 
Configuration Utility (or run Configuration Utility (or run Msconfig.exeMsconfig.exe))

AutorunsAutoruns (from (from SysinternalsSysinternals) shows many more places things CAN be ) shows many more places things CAN be 
defined to startdefined to start

AutorunsAutoruns ((SysinternalsSysinternals)) MsconfigMsconfig
(in (in \\WindowsWindows\\pchealthpchealth\\helpctrhelpctr\\binariesbinaries))

End of Part 1End of Part 1
Next: Troubleshooting Memory ProblemsNext: Troubleshooting Memory Problems
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OutlineOutline
1.1. Process & Thread TroubleshootingProcess & Thread Troubleshooting

2.2. Understanding & Troubleshooting Memory Understanding & Troubleshooting Memory 
ProblemsProblems

3.3. Troubleshooting with Troubleshooting with FilemonFilemon & & RegmonRegmon

4.4. Crash Dump AnalysisCrash Dump Analysis

5.5. Boot & Startup TroubleshootingBoot & Startup Troubleshooting

2-2

Troubleshooting Memory ProblemsTroubleshooting Memory Problems

System and process memory usage may degrade System and process memory usage may degrade 
performanceperformance

Or eventually cause process failuresOr eventually cause process failures

How do you determine memory leaks?How do you determine memory leaks?
Process vs. system?Process vs. system?

How do you know if you need more memory?How do you know if you need more memory?

How do you size your page file?How do you size your page file?

What do system and process memory counters really What do system and process memory counters really 
mean?mean?

Understanding process and system memory information can help Understanding process and system memory information can help 
answer these questionsanswer these questions……
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Windows Memory ManagementWindows Memory Management

Demand paged virtual memoryDemand paged virtual memory
Unit of protection and usage is one pageUnit of protection and usage is one page

x86, EM64T, AMD64: 4 KBx86, EM64T, AMD64: 4 KB
Itanium 8 KBItanium 8 KB

Pages are read in on demand and written out when necessary (to Pages are read in on demand and written out when necessary (to 
make room for other memory needs)make room for other memory needs)

Provides illusion of flat virtual address space to each Provides illusion of flat virtual address space to each 
processprocess

3232--bit: 4 GB, 64bit: 4 GB, 64--bit: 16 bit: 16 ExabytesExabytes (theoretical)(theoretical)

Intelligent, automatic sharing of memory Intelligent, automatic sharing of memory 
Supports up to 128 GB (32Supports up to 128 GB (32--bit systems) or 1024 GB (64bit systems) or 1024 GB (64--
bit systems) physical memorybit systems) physical memory

2-4

Physical Memory Limits (in GB)Physical Memory Limits (in GB)

128

32

4

2

4

4

x64 32-
bit

1024

64

n/a

n/a

16

n/a

IA-64 64-
bit

102464Server 2003 
Datacenter

6432Server 2003 
Enterprise

164Server 2003  
Standard

n/a2Server 2003 Web 
Edition

164XP Professional

n/a4XP Home

x64 64-bitx86
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Process Memory UsageProcess Memory Usage
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Code: EXE/DLLs
Data: EXE/DLL 

static storage, per-
thread user mode 

stacks, process 
heaps, etc.

00000000

7FFFFFFF

Code:Code:
NTOSKRNL, HAL, NTOSKRNL, HAL, 
driversdrivers
Data:Data: kernel stacks,kernel stacks,

File system cacheFile system cache
NonNon--paged pool,paged pool,
Paged poolPaged pool

FFFFFFFF

80000000

Process page tables,
hyperspace

C0000000

3232--Bit Virtual Bit Virtual 
Address Space Address Space 
(x86)(x86)

2 GB per2 GB per--processprocess
Address space of one process is not Address space of one process is not 
directly reachable from other directly reachable from other 
processesprocesses

2 GB system2 GB system--widewide
The operating system is loaded here, The operating system is loaded here, 
and appears and appears 
in every processin every process’’s s 
address spaceaddress space
The operating system is not a process The operating system is not a process 
(though there are processes that do (though there are processes that do 
things for the OS, more or less in things for the OS, more or less in 
““backgroundbackground””))

Unique per Unique per 
process,  process,  

accessible in accessible in 
user or kernel user or kernel 

modemode

System wide,System wide,
accessible  accessible  

only in kernel only in kernel 
modemode

Per process, Per process, 
accessible accessible 

only in kernel only in kernel 
modemode
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Unique per 
process
(= per appl.),
user mode

.EXE code.EXE code
GlobalsGlobals

PerPer--thread user thread user 
mode stacksmode stacks

.DLL code.DLL code
Process heapsProcess heaps

Exec, kernel, HAL,Exec, kernel, HAL,
drivers, etc.drivers, etc.

00000000

BFFFFFFF

FFFFFFFF

C0000000

Unique per Unique per 
process,  process,  

accessible in accessible in 
user or kernel user or kernel 

modemode

3GB Process 3GB Process 
Space OptionSpace Option

/3GB option in BOOT.INI/3GB option in BOOT.INI
Provides up to 3 GB perProvides up to 3 GB per--process process 
address space address space 
Windows Server 2003 & XP SP2 Windows Server 2003 & XP SP2 
supports variations from 2GB to supports variations from 2GB to 
3GB (/USERVA=)3GB (/USERVA=)

Restrictions to use:Restrictions to use:
Only available on Windows 2000 Only available on Windows 2000 
Advanced Server & Server 2003 & Advanced Server & Server 2003 & 
XP SP2XP SP2

Limits memory to 16 GBLimits memory to 16 GB

.EXE must have .EXE must have ““large address large address 
space awarespace aware”” flag in image header, flag in image header, 
or theyor they’’re limited to 2 GB (specify at re limited to 2 GB (specify at 
link time or with link time or with imagecfg.exeimagecfg.exe in in 
Resource Kit)Resource Kit)

System wide,System wide,
accessible  accessible  

only in kernel only in kernel 
modemode

Per process, Per process, 
accessible accessible 

only in kernel only in kernel 
modemode

Process page tables,Process page tables,
hyperspacehyperspace

2-8

8192 GB
(8 TB)
User

process 
space

6657 GB6657 GB
SystemSystem
SpaceSpace

6464--bit Address Spacesbit Address Spaces

7152 GB
(7 TB)
User

process 
space

6144 GB6144 GB
SystemSystem
SpaceSpace

x64 Itanium

6464--bits = 17,179,869,184 GBbits = 17,179,869,184 GB
x64 today supports 48 bits virtual = 262,144 GBx64 today supports 48 bits virtual = 262,144 GB

IAIA--64 today support 50 bits virtual = 1,048,576 GB64 today support 50 bits virtual = 1,048,576 GB
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Process Memory UsageProcess Memory Usage

What limits total process private virtual memory?What limits total process private virtual memory?
Page file size + (most of) physical memoryPage file size + (most of) physical memory
Called Called ““Commit limitCommit limit””

What limits physical size of a process?What limits physical size of a process?
Physical memory + Memory Manager policiesPhysical memory + Memory Manager policies

Based on memory demands and paging ratesBased on memory demands and paging rates

2-10

Process Memory Usage: Process Memory Usage: ““Working SetWorking Set””
Working set:  All the physical pages Working set:  All the physical pages ““ownedowned”” by a processby a process

Essentially, all the pages the process can reference without incEssentially, all the pages the process can reference without incurring urring 
a page faulta page fault

A process always starts with an empty working setA process always starts with an empty working set
Pages itself into existencePages itself into existence

XP XP prefetchesprefetches pages to speed up application startuppages to speed up application startup
Many page faults may be resolved from memoryMany page faults may be resolved from memory

PerfMon
Process “WorkingSet”

newer pages older pages
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““MemMem UsageUsage”” = physical = physical 
memory used by process memory used by process 
(working set (working set sizesize, not , not 
working set limit)working set limit)

Note:  Shared pages are Note:  Shared pages are 
counted in each counted in each 
processprocess

““VM SizeVM Size”” = private (not = private (not 
shared) committed virtual shared) committed virtual 
space in processes == space in processes == 
potential potential pagefilepagefile usageusage
““MemMem UsageUsage”” in status bar in status bar 
is is notnot total of total of ““MemMem UsageUsage””
column (see later column (see later slide)cslide)c

Screen snapshot from:Screen snapshot from:
Task Manager | Processes tabTask Manager | Processes tab

1

2

3

1

2

3

Process Memory InformationProcess Memory Information
Task ManagerTask Manager
Processes tabProcesses tab

2-12

Process ExplorerProcess Explorer

1 2

3

““Private BytesPrivate Bytes”” =  Task Manager =  Task Manager ““VM SizeVM Size””
““Working SetWorking Set”” = Task Manager = Task Manager ““MemMem UsageUsage””
Commit Charge shown as percentage in status barCommit Charge shown as percentage in status bar

1
2

3
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Shared MemoryShared Memory
Like most modern Like most modern OSsOSs, , 
Windows provides a way for processes to Windows provides a way for processes to 
share memoryshare memory

High speed IPC (used by LPC, which is used High speed IPC (used by LPC, which is used 
by RPC)by RPC)

Threads share address space, but applications Threads share address space, but applications 
may be divided into multiple processes for may be divided into multiple processes for 
stability reasonsstability reasons

Processes can also create shared memory Processes can also create shared memory 
sectionssections

Called page file backed file mapping objectsCalled page file backed file mapping objects

Full Windows securityFull Windows security

It does this automatically for shareable pagesIt does this automatically for shareable pages
E.g., code pages in an EXE or DLLE.g., code pages in an EXE or DLL

Process 1Process 1
AddressAddress
SpaceSpace

Process 2Process 2
AddressAddress
SpaceSpace

Physical Physical 
MemoryMemory

DLL DLL 
codecode

2-14

Viewing the Working SetViewing the Working Set

Working set size counts shared pages in each working setWorking set size counts shared pages in each working set

VadumpVadump (Resource Kit) can dump the breakdown of (Resource Kit) can dump the breakdown of 
private, shareable, and shared pagesprivate, shareable, and shared pages

C:C:\\> > VadumpVadump ––o o ––p 3968p 3968
Module Working Set Contributions in pagesModule Working Set Contributions in pages

Total   Private Shareable    Shared ModuleTotal   Private Shareable    Shared Module
14         3        11         0 NOTEPAD.EXE14         3        11         0 NOTEPAD.EXE
46         3         0        43 46         3         0        43 ntdll.dllntdll.dll
36         1         0        35 kernel32.dll36         1         0        35 kernel32.dll
7         2         0         5 comdlg32.dll7         2         0         5 comdlg32.dll
17         2         0        15 17         2         0        15 SHLWAPI.dllSHLWAPI.dll
44         4         0        40 44         4         0        40 msvcrt.dllmsvcrt.dll
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Working Set ReplacementWorking Set Replacement

When process reaches working set maximum, must give up When process reaches working set maximum, must give up 
pagespages

This is called a local page replacement policy This is called a local page replacement policy 
(versus a global replacement policy common on Unix)(versus a global replacement policy common on Unix)

Means that a single process cannot take over all of physical Means that a single process cannot take over all of physical 
memory unless other processes arenmemory unless other processes aren’’t using itt using it

Page replacement algorithm is least recently accessedPage replacement algorithm is least recently accessed
Windows 2000: only on Windows 2000: only on uniprocessoruniprocessor; Windows XP and Server ; Windows XP and Server 
2003:  All systems2003:  All systems

Kept in 
memory on 
standby or 
modified 
page list

Paging ListsPaging Lists
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Managing Physical MemoryManaging Physical Memory

System keeps System keeps unownedunowned physical pages on one of physical pages on one of 
several listsseveral lists

Free page listFree page list

Modified page listModified page list

Standby page listStandby page list

Zero page listZero page list

Bad page list Bad page list –– pages that failed memory test at system pages that failed memory test at system 
startupstartup

2-18

Standby And Modified Page ListsStandby And Modified Page Lists

Modified pages go to modified (dirty) listModified pages go to modified (dirty) list
Avoids writing pages back to disk too soonAvoids writing pages back to disk too soon

Unmodified pages go to standby (clean) listUnmodified pages go to standby (clean) list

They form a systemThey form a system--wide cache of wide cache of ““pages likely to be pages likely to be 
needed againneeded again””

Pages can be faulted back into a process from the standby and Pages can be faulted back into a process from the standby and 
modified page listmodified page list

These are counted as page faults, but not These are counted as page faults, but not 
page readspage reads
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Free And Zero Page ListsFree And Zero Page Lists

Free Page ListFree Page List
Used for page readsUsed for page reads

Private modified pages go here on process exitPrivate modified pages go here on process exit

Pages contain junk in them (e.g., not zeroed)Pages contain junk in them (e.g., not zeroed)

On most busy systems, this is emptyOn most busy systems, this is empty

Zero Page ListZero Page List
Used to satisfy demand zero page faultsUsed to satisfy demand zero page faults

References to private pages that have not been created yetReferences to private pages that have not been created yet

When free page list has 8 or more pages, a priority zero thread When free page list has 8 or more pages, a priority zero thread is is 
awoken to zero themawoken to zero them

On most busy systems, this is empty tooOn most busy systems, this is empty too
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Paging DynamicsPaging Dynamics

StandbyStandby
PagePage
ListList

ZeroZero
PagePage
ListList

FreeFree
PagePage
ListList

WorkingWorking
SetsSets

page read from page read from 
disk or kernel disk or kernel 
allocationsallocations

demand zero demand zero 
page faultspage faults

working set working set 
replacementreplacement

ModifiedModified
PagePage
ListList

modifiedmodified
pagepage
writerwriter

zerozero
pagepage

threadthread

““softsoft””
pagepage
faultsfaults

BadBad
PagePage
ListList

Private pages Private pages 
at process exitat process exit

““global global 
validvalid””
faultsfaults
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Memory Management InformationMemory Management Information
Task ManagerTask Manager
Performance tabPerformance tab

““AvailableAvailable”” = sum of free, = sum of free, 
standby, and zero page lists standby, and zero page lists 
(physical)(physical)

Majority are likely standby Majority are likely standby 
pagespages

““System CacheSystem Cache”” = size of = size of 
standby list + size of system standby list + size of system 
working set (file cache, paged working set (file cache, paged 
pool, pool, pageablepageable OS/driver code OS/driver code 
& data)& data)

Screen snapshot from: Screen snapshot from: 
Task Manager | Performance tabTask Manager | Performance tab

1

1
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Viewing the Paging ListsViewing the Paging Lists

Only way to get actual size of physical memory lists is to use Only way to get actual size of physical memory lists is to use 
!!memusagememusage in Kernel Debuggerin Kernel Debugger

lkdlkd> !> !memusagememusage

loading PFN databaseloading PFN database

Zeroed:      0 (     0 kb)Zeroed:      0 (     0 kb)

Free:      3 (    12 kb)Free:      3 (    12 kb)

Standby:  98248 (392992 kb)Standby:  98248 (392992 kb)

Modified:    563 (  2252 kb)Modified:    563 (  2252 kb)

ModifiedNoWriteModifiedNoWrite:      0 (     0 kb):      0 (     0 kb)

Active/Valid:  93437 (373748 kb)Active/Valid:  93437 (373748 kb)

Transition:      1 (     4 kb)Transition:      1 (     4 kb)

Unknown:      0 (     0 kb)Unknown:      0 (     0 kb)

TOTAL: 192252 (769008 kb)TOTAL: 192252 (769008 kb)

Screen snapshot from:kernel debugger Screen snapshot from:kernel debugger 
!!memusagememusage commandcommand
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Do I Need More Memory?Do I Need More Memory?
No single performance counter can answer thisNo single performance counter can answer this

Page fault activity doesnPage fault activity doesn’’t necessarily show itt necessarily show it
First, donFirst, don’’t forget to monitor page reads, not page faults (soft t forget to monitor page reads, not page faults (soft 
faults donfaults don’’t indicate a need for more memory)t indicate a need for more memory)

But, some hard page faults are unavoidable!But, some hard page faults are unavoidable!
Process startupProcess startup

Normal file I/O done via pagingNormal file I/O done via paging

The Solomon/Russinovich The Solomon/Russinovich ““SimpleSimple”” formula:formula:
Available Memory is small most of the timeAvailable Memory is small most of the time

To be any more sure, must trace I/Os and analyzeTo be any more sure, must trace I/Os and analyze
If I/Os occur frequently to the same part of the same files OR If I/Os occur frequently to the same part of the same files OR 
reads from reads from Pagefile.sysPagefile.sys, memory might help, memory might help

Note: Note: FilemonFilemon does not show reads from does not show reads from Pagefile.sysPagefile.sys if in basic if in basic 
modemode
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Notepad Word Explorer System Available

Avail. RAM Optimizer

SystemExplorerWordNotepad

Available

Before:

During:

After:

Why Why ““Memory OptimizersMemory Optimizers”” are are 
FraudwareFraudware

See article on this topic at
http://www.winnetmag.com/Windows/Article/ArticleID/41095/41095.html
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Page FilesPage Files
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Page FilesPage Files
What gets sent to the paging file?What gets sent to the paging file?

Not code Not code –– only modified data (code can be reonly modified data (code can be re--read from image read from image 
file anytime)file anytime)

When do pages get paged out?When do pages get paged out?
Only when necessaryOnly when necessary

Page file space is only reserved at the time pages are written Page file space is only reserved at the time pages are written 
outout

Once a page is written to the paging file, the space is occupiedOnce a page is written to the paging file, the space is occupied
until the memory is deleted (e.g., at process exit), even if theuntil the memory is deleted (e.g., at process exit), even if the
page is read back from diskpage is read back from disk

Can run with no paging fileCan run with no paging file
Windows NT4/Windows 2000:  Zero Windows NT4/Windows 2000:  Zero pagefilepagefile size actually size actually 
created a 20MB temporary page filecreated a 20MB temporary page file
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Sizing The Page FileSizing The Page File
Given understanding of page file usage, how big Given understanding of page file usage, how big 
should the total paging file space be?should the total paging file space be?
(Windows supports multiple paging files)(Windows supports multiple paging files)

Size should depend on total private virtual Size should depend on total private virtual 
memory used by applications and driversmemory used by applications and drivers

Therefore, not related to RAM size (except for taking Therefore, not related to RAM size (except for taking 
a full memory dump)a full memory dump)
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Sizing The Page FileSizing The Page File
Worst case:  Windows has to page all private data out to Worst case:  Windows has to page all private data out to 
make room for code pagesmake room for code pages

To handle, minimum size should be the maximum of VM usage To handle, minimum size should be the maximum of VM usage 
((““Commit Charge PeakCommit Charge Peak””))

Hard disk space is cheap, so why not double thisHard disk space is cheap, so why not double this

Normally, make maximum size same as minimumNormally, make maximum size same as minimum
But, max size could be much larger if there will be infrequent But, max size could be much larger if there will be infrequent 
demands for large amounts of page file spacedemands for large amounts of page file space

Performance problem:  Page file extension will likely be very Performance problem:  Page file extension will likely be very 
fragmentedfragmented
Extension is deleted on reboot, thus returning to a contiguous pExtension is deleted on reboot, thus returning to a contiguous page age 
filefile
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Memory Management InformationMemory Management Information
Task ManagerTask Manager
Performance tabPerformance tab

Total committed private virtual memory Total committed private virtual memory 
(total of (total of ““VM SizeVM Size”” in process tab + in process tab + 
Kernel Kernel 
Memory Paged)Memory Paged)
not all of this space has actually been not all of this space has actually been 
used in the paging files; it is used in the paging files; it is ““how how 
much much wouldwould be used if it was all paged be used if it was all paged 
outout””
““Commit charge limitCommit charge limit”” = sum of = sum of 
physical memory available for physical memory available for 
processes + current total size of processes + current total size of 
paging file(s)paging file(s)
does not reflect true maximum page does not reflect true maximum page 
file sizes (expansion)file sizes (expansion)
when when ““totaltotal”” reaches reaches ““limitlimit””, further , further 
VirtualAllocVirtualAlloc attempts by attempts by anyany process process 
will failwill fail

Screen snapshot from: 
Task Manager | Performance tab

2
1

1

1

1

Memory LeaksMemory Leaks
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Process Memory LeaksProcess Memory Leaks
System says System says ““running low on virtual memoryrunning low on virtual memory””

Before increasing size of page file, look for a process Before increasing size of page file, look for a process 
(or system) memory leak(or system) memory leak

Look for who is consuming Look for who is consuming pagefilepagefile spacespace
Process memory leak:  Check Task Manager, Process memory leak:  Check Task Manager, 
Processes tab, VM Size columnProcesses tab, VM Size column

Or Or PerfmonPerfmon ““private bytesprivate bytes””, same counter, same counter
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Lab: Process Memory LeakLab: Process Memory Leak
Leakyapp.exeLeakyapp.exe is in the 2000 Resource Kitis in the 2000 Resource Kit

Continuously allocates private, Continuously allocates private, nonshareablenonshareable virtual virtual 
memorymemory

When there is no more, it just keeps trying..When there is no more, it just keeps trying..

To cause a memory leak, run it and press Start To cause a memory leak, run it and press Start 
LeakingLeaking

Run several copies to fill Run several copies to fill pagefilepagefile more quicklymore quickly
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Kernel Memory LeaksKernel Memory Leaks
Or, a growing Memory Or, a growing Memory 
Usage and Paged pool Usage and Paged pool 
usageusage

A driver leaking A driver leaking nonpagednonpaged pool pool 
shows up as large and growing shows up as large and growing 
NonpagedNonpaged pool usagepool usage
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Handle LeaksHandle Leaks

Processes that open resources but donProcesses that open resources but don’’t close t close 
them can exhaust system memorythem can exhaust system memory

Check total handle count in Task Manager Check total handle count in Task Manager 
Performance tabPerformance tab
To find offending process, on Process tab add Handle To find offending process, on Process tab add Handle 
Count and sort by that columnCount and sort by that column
Using Process Explorer handle view with differences Using Process Explorer handle view with differences 
highlighting you can even find which highlighting you can even find which handle(shandle(s) are not ) are not 
being closedbeing closed

Sysinternals Sysinternals TestlimitTestlimit with with ––h option leaks handlesh option leaks handles
http://www.sysinternals.com/files/testlimit.ziphttp://www.sysinternals.com/files/testlimit.zip
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Two system memory poolsTwo system memory pools
““NonpagedNonpaged PoolPool”” and and ““Paged PoolPaged Pool””

Used for Used for systemwidesystemwide persistent data (visible from any persistent data (visible from any 
process context) process context) 

Pool sizes are a function of memory size & Server Pool sizes are a function of memory size & Server 
vs. Workstationvs. Workstation

Can be Can be overiddenoveridden in Registry:in Registry:
HKLMHKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\ControlControl\\Session ManagerSession Manager

\\Memory ManagementMemory Management

Kernel Memory PoolsKernel Memory Pools

2-37

Kernel Memory PoolsKernel Memory Pools
NonpagedNonpaged poolpool

Has initial size and upper limit (can be grown dynamically, up tHas initial size and upper limit (can be grown dynamically, up to the o the 
max)max)
3232--bit upper limit: 256 MB on x86 (NT4: 128MB)bit upper limit: 256 MB on x86 (NT4: 128MB)

6464--bit limit: 128 GB bit limit: 128 GB 

Paged poolPaged pool
3232--bit upper limit:  650MB (Windows Server 2003), 470MB bit upper limit:  650MB (Windows Server 2003), 470MB 
(Windows 2000), 192MB (Windows NT 4.0)(Windows 2000), 192MB (Windows NT 4.0)

6464--bit limit: 128 GBbit limit: 128 GB

Pool size performance counters display current size, not Pool size performance counters display current size, not 
maximummaximum

To display maximums, use To display maximums, use ““!vm!vm”” kernel debugger commandkernel debugger command
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Process ExplorerProcess Explorer
Or, just use Process ExplorerOr, just use Process Explorer’’s System Information dialogs System Information dialog
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Lab: Causing a Pool LeakLab: Causing a Pool Leak
Run Run NotMyFaultNotMyFault and and 
select select ““Leak PoolLeak Pool””

http://www.sysinternals.chttp://www.sysinternals.c
om/files/notmyfault.zipom/files/notmyfault.zip

Allocates paged pool Allocates paged pool 
buffers and doesnbuffers and doesn’’t free t free 
themthem

Stops leaking when you Stops leaking when you 
select select ““Stop LeakingStop Leaking””
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Debugging Pool LeaksDebugging Pool Leaks

Two options:Two options:
PoolmonPoolmon

In the Support Tools and the Device Driver Kit In the Support Tools and the Device Driver Kit 
(DDK)(DDK)

Requires that you turn on Pool Tagging with Requires that you turn on Pool Tagging with 
GflagsGflags on Windows NT and Windows 2000on Windows NT and Windows 2000

Driver VerifierDriver Verifier

Select all driversSelect all drivers

Turn on pool trackingTurn on pool tracking

2-41

Monitoring Pool UsageMonitoring Pool Usage
Poolmon.exePoolmon.exe (Support Tools)(Support Tools)

Shows paged and Shows paged and nonpagednonpaged pool consumption by data structure pool consumption by data structure ““tagtag””
Must first turn on Must first turn on ““pool taggingpool tagging”” with Resource Kit with Resource Kit gflagsgflags tool & reboottool & reboot

On by default in Windows Server 2003 (not in XP or Win2000)On by default in Windows Server 2003 (not in XP or Win2000)

Controls:Controls: ““pp”” to toggle between to toggle between nonpagednonpaged, paged pool, or both, paged pool, or both
““bb”” to sort by total # of bytes, to sort by total # of bytes, ““aa”” to sort by # of allocations, to sort by # of allocations, ““tt”” to sort by structure tagto sort by structure tag
““??”” displays helpdisplays help
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Troubleshooting with Troubleshooting with PoolmonPoolmon

Once you find pool tag that is leaking, need to find Once you find pool tag that is leaking, need to find 
which driver is creating the tagwhich driver is creating the tag
1.1. Try looking up in Windows Debugging Tools subfolder Try looking up in Windows Debugging Tools subfolder 

\\triagetriage\\pooltag.txtpooltag.txt
May not be there if 3May not be there if 3rdrd party driverparty driver

2.2. If not, run Strings (from Sysinternals) on all drivers:If not, run Strings (from Sysinternals) on all drivers:
strings strings \\windowswindows\\system32system32\\driversdrivers\\*.sys | *.sys | findstrfindstr

XyzzXyzz

Or, use new Or, use new PoolmonPoolmon in 2003 DDK to generate local in 2003 DDK to generate local 
pool tagspool tags

PoolmonPoolmon --c  will create a c  will create a ““localtag.txtlocaltag.txt”” (if not present)(if not present)

Scans binaries of loaded drivers for pool tagsScans binaries of loaded drivers for pool tags
Still missed drivers that are loaded but deletedStill missed drivers that are loaded but deleted
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Finding All the DriversFinding All the Drivers
Note that while most drivers are in Note that while most drivers are in \\WindowsWindows\\System32System32\\Drivers, Drivers, 
they can be loaded from anywherethey can be loaded from anywhere

To check the location of all drivers:To check the location of all drivers:
Run Msinfo32.exe, click on Software EnvironmentRun Msinfo32.exe, click on Software Environment-->System Drivers, >System Drivers, 
sort by Pathsort by Path

Or, type Or, type ““DriverqueryDriverquery /v/v”” (XP & 2003)(XP & 2003)

However, some drivers are deleted after they are loadedHowever, some drivers are deleted after they are loaded
Binary file and registry key can be deleted after loadBinary file and registry key can be deleted after load

Examples: Process Explorer, Filemon, RegmonExamples: Process Explorer, Filemon, Regmon

Instead, list system loaded kernel mode module listInstead, list system loaded kernel mode module list
Drivers.exeDrivers.exe or or Pstat.exePstat.exe

““lm klm k”” in Kernel Debuggerin Kernel Debugger

Process Explorer DLL view of System processProcess Explorer DLL view of System process
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Troubleshooting with Driver VerifierTroubleshooting with Driver Verifier
Use Driver Verifier to enable pool tracking for all Use Driver Verifier to enable pool tracking for all 
drivers (or ones of interest)drivers (or ones of interest)

System tracks pool usage by driverSystem tracks pool usage by driver
PoolmonPoolmon looks at pool usage by structure taglooks at pool usage by structure tag
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Looking for LeaksLooking for Leaks
Reboot and look at the pool usage of each driverReboot and look at the pool usage of each driver

A A leakerleaker exhibits the followingexhibits the following
Current allocations is always close to or equal to the peakCurrent allocations is always close to or equal to the peak

The peak grows over timeThe peak grows over time

If the leak is significant the peak allocations or bytes will beIf the leak is significant the peak allocations or bytes will be largelarge
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End of Part 2End of Part 2
Next: Troubleshooting with Next: Troubleshooting with FilemonFilemon & & RegmonRegmon
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5.5. Boot & Startup TroubleshootingBoot & Startup Troubleshooting
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Troubleshooting Application FailuresTroubleshooting Application Failures

Most applications do a poor job of reporting fileMost applications do a poor job of reporting file--
related or registryrelated or registry--related errorsrelated errors

E.g. permissions problemsE.g. permissions problems

Missing filesMissing files

Missing or corrupt registry dataMissing or corrupt registry data
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Troubleshooting Application FailuresTroubleshooting Application Failures

When in doubt, run Filemon and Regmon!When in doubt, run Filemon and Regmon!
Filemon monitors File I/O; Regmon monitors registry Filemon monitors File I/O; Regmon monitors registry 
I/OI/O

Ideal for troubleshooting a wide variety of Ideal for troubleshooting a wide variety of 
application failuresapplication failures

Also useful for to understand and tune file system Also useful for to understand and tune file system 
accessaccess

E.g. understanding hard drive activityE.g. understanding hard drive activity

3-4

Using Regmon/FilemonUsing Regmon/Filemon

Two basic techniques:Two basic techniques:
Go to end of log and look backwards to where Go to end of log and look backwards to where 
problem occurred or is evident and focused on the last problem occurred or is evident and focused on the last 
things donethings done
Compare a good log with a bad logCompare a good log with a bad log

Often comparing the I/O and Registry activity of a Often comparing the I/O and Registry activity of a 
failing process with one that works may point to failing process with one that works may point to 
the problemthe problem

Have to first massage log file to remove data that Have to first massage log file to remove data that 
differs run to rundiffers run to run

Delete first 3 columns (they are always different: line #, time,Delete first 3 columns (they are always different: line #, time,
process id)process id)

Easy to do with Excel by deleting columnsEasy to do with Excel by deleting columns

Then compare with FC (built in tool) or Then compare with FC (built in tool) or WindiffWindiff
(Resource Kit)(Resource Kit)
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Example: Word CrashExample: Word Crash

While typing in the document Word XP closes While typing in the document Word XP closes 
without any promptswithout any prompts

See filemonSee filemon--lab2.log and try and determine whylab2.log and try and determine why
Go to end of Filemon log and search backwards for Go to end of Filemon log and search backwards for 
Winword.exeWinword.exe

Stop at first unexplainable activityStop at first unexplainable activity

3-6

Solution: Word CrashSolution: Word Crash

Working backwards, the first Working backwards, the first ““strangestrange”” or unexplainable or unexplainable 
behavior are the constant reads past end of file to behavior are the constant reads past end of file to 
MSSP3ES.LEXMSSP3ES.LEX

User looked up what .LEX file wasUser looked up what .LEX file was
Related to Word proofing toolsRelated to Word proofing tools

Uninstalled and reinstalled proofing tools & problem went awayUninstalled and reinstalled proofing tools & problem went away
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DLL ProblemsDLL Problems
Process Explorer may solve a DLL versioning issue, but Process Explorer may solve a DLL versioning issue, but 
may not if:may not if:

A DLL is missingA DLL is missing

The order of DLL loads is relevantThe order of DLL loads is relevant

So, use Filemon!So, use Filemon!
Look at the last DLL Look at the last DLL openedopened before the application diedbefore the application died

Compare the startup of a working with a failing applicationCompare the startup of a working with a failing application
Missing or inaccessible DLLs often not reported correctlyMissing or inaccessible DLLs often not reported correctly

Look for Look for ““NOTFOUNDNOTFOUND”” or or ““ACCESS DENIEDACCESS DENIED””

May be opening wrong versions due to wrong versions being in May be opening wrong versions due to wrong versions being in 
folders in PATHfolders in PATH

3-10

Example: Word DiesExample: Word Dies

Word97 starts and a few seconds later gets a Dr. Word97 starts and a few seconds later gets a Dr. 
Watson (access violation)Watson (access violation)

Customer tried reCustomer tried re--installing Office installing Office –– still failedstill failed

Solution:Solution:
Ran Filemon, looked at last DLL loaded before Dr. Ran Filemon, looked at last DLL loaded before Dr. 
WatsonWatson

It was a printer DLLIt was a printer DLL

Uninstalled printer Uninstalled printer –– problem went awayproblem went away
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Example: Access HangsExample: Access Hangs

Problem: Access 2000 would hang when trying Problem: Access 2000 would hang when trying 
to import an Excel fileto import an Excel file

Worked fine on other usersWorked fine on other users’’ workstationsworkstations

User had Access 97 and Access 2000 installedUser had Access 97 and Access 2000 installed

Compare filemonCompare filemon--lab4lab4--good.log with filemongood.log with filemon--
lab4lab4--bad.logbad.log

3-14

Solution: Access HangsSolution: Access Hangs

Failing system was loading an old Access DLL Failing system was loading an old Access DLL 
from from \\winntwinnt\\system32 due to having installed system32 due to having installed 
Access 97 previouslyAccess 97 previously

First unexplainable difference was that First unexplainable difference was that Accwiz.dllAccwiz.dll
was being loaded from two different directorieswas being loaded from two different directories

Removed DLL in Removed DLL in \\winntwinnt\\system32 and problem system32 and problem 
went awaywent away
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Example: Access DeniedExample: Access Denied

AOL reported this error:AOL reported this error:

Filemon showed this:Filemon showed this:

User did not have admin rights to AOL directoryUser did not have admin rights to AOL directory

waol.exewaol.exe OPEN   C:OPEN   C:\\PROGRA~1PROGRA~1\\AMERIC~1.0AMERIC~1.0\\IDBIDB\\main.ind  ACCESS DENIEDmain.ind  ACCESS DENIED
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Example: Outlook Application ErrorExample: Outlook Application Error
For example, an Outlook application failed with this For example, an Outlook application failed with this 
error:error:

Ran Filemon and found it was getting Access Ran Filemon and found it was getting Access 
DeniedDenied

Someone had misread a request to remove EDIT Someone had misread a request to remove EDIT 
rights and removed all rightsrights and removed all rights
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File I/O Activity File I/O Activity 

Sometimes, applications perform needless file I/OSometimes, applications perform needless file I/O
Run Filemon to see how Run Filemon to see how ““quietquiet”” your system is when your system is when 
you think nothing is going onyou think nothing is going on

Some applications perform inefficient file I/OSome applications perform inefficient file I/O
May be due to libraries used in application that May be due to libraries used in application that 
indirectly cause needless I/Oindirectly cause needless I/O

3-19

Lab: Notepad File SaveLab: Notepad File Save

1.1. Run FilemonRun Filemon

2.2. Set filter to only include Set filter to only include Notepad.exeNotepad.exe

3.3. Run NotepadRun Notepad

4.4. Type some textType some text

5.5. Save file as Save file as ““test.txttest.txt””

6.6. Go back to FilemonGo back to Filemon

7.7. Stop loggingStop logging

8.8. Set highlight to Set highlight to ““test.txttest.txt””

9.9. Find line representing creation of new fileFind line representing creation of new file
Hint: look for create operationHint: look for create operation
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Understanding Disk ActivityUnderstanding Disk Activity
Performance counters show which disks are Performance counters show which disks are 
being hit, but not which filesbeing hit, but not which files

Filemon pinpoints which Filemon pinpoints which file(sfile(s) are being ) are being 
accessed and how frequentlyaccessed and how frequently

Example: used Filemon on a server to determine Example: used Filemon on a server to determine 
which which file(sfile(s) were being accessed most ) were being accessed most 
frequentlyfrequently

Imported into Excel and make a pie chart by file Imported into Excel and make a pie chart by file 
name or operation typename or operation type

Moved these files to a different disk on a different Moved these files to a different disk on a different 
controllercontroller

3-21

AgendaAgenda

Troubleshooting with FilemonTroubleshooting with Filemon

Troubleshooting with RegmonTroubleshooting with Regmon
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Configuration ProblemsConfiguration Problems
Missing, corrupted or overlyMissing, corrupted or overly--secure Registry secure Registry 
settings often lead to application crashes and settings often lead to application crashes and 
errorserrors

Some applications donSome applications don’’t completely remove t completely remove 
registry data at uninstallregistry data at uninstall

Regmon may yield the answerRegmon may yield the answer……

3-23

Registry Activity Registry Activity 

Normally, registry activity should be only at Normally, registry activity should be only at 
application/system startup and exitapplication/system startup and exit

But, sadly, lots of processes perform needless But, sadly, lots of processes perform needless 
registry queryingregistry querying……

Try running Regmon to see how Try running Regmon to see how ““quietquiet”” your your 
registry isregistry is



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

3-24

Regmon ApplicationsRegmon Applications

If you suspect registry data is causing problems, If you suspect registry data is causing problems, 
rename the key and rerename the key and re--run the applicationrun the application

Most applications reMost applications re--create user settings when runcreate user settings when run

In this way, the data wonIn this way, the data won’’t be seen by the applicationt be seen by the application
Can always rename the key backCan always rename the key back

3-25

Example: Missing Word ToolbarExample: Missing Word Toolbar

Problem:Problem:
User somehow disabled all toolbars and menus in User somehow disabled all toolbars and menus in 
Word Word 

No way to open files, change settings etc.No way to open files, change settings etc.

Solution:Solution:
With Regmon, captured startup of WordWith Regmon, captured startup of Word

Found location of userFound location of user--specific settings for Wordspecific settings for Word

Deleted this Registry keyDeleted this Registry key

ReRe--ran Word, which reran Word, which re--created user settings from created user settings from 
scratchscratch



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

3-26

Example: IE ErrorExample: IE Error

Internet Explorer failed to start with this Internet Explorer failed to start with this 
error:error:

See c:See c:\\lablab\\regmonregmon--lab2.loglab2.log
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Solution: IE ErrorSolution: IE Error

Looked backwards from end of Regmon logLooked backwards from end of Regmon log

Last queries were to:Last queries were to:
HKCUHKCU\\SoftwareSoftware\\MicrosoftMicrosoft\\Internet Connection WizardInternet Connection Wizard

Looked here and found a single value Looked here and found a single value 
““CompletedCompleted”” set to 0set to 0

Compared to other usersCompared to other users——theirs was 1theirs was 1

Set this manually to 1 and problem went awaySet this manually to 1 and problem went away
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Example: IE HangsExample: IE Hangs
Internet Explorer hung when startedInternet Explorer hung when started

Default internet connection was set, but wasnDefault internet connection was set, but wasn’’t being t being 
dialeddialed

Dialing the connection first manually and Dialing the connection first manually and thenthen
running IE workedrunning IE worked

Background information:Background information:
User had previously installed the AT&T Dialer User had previously installed the AT&T Dialer 
program, but had uninstalled it and created dial up program, but had uninstalled it and created dial up 
connection manuallyconnection manually

3-29

Solution: IE HangsSolution: IE Hangs

Ran RegmonRan Regmon

Looked backwards from end (at the point IE was Looked backwards from end (at the point IE was 
hung)hung)

Found references to ATT under a Found references to ATT under a PhoneBookPhoneBook keykey

Renamed ATT key and problem went awayRenamed ATT key and problem went away

Conclusion: registry junk was left from uninstallConclusion: registry junk was left from uninstall
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Using RegmonUsing Regmon

Sometimes queries to what is Sometimes queries to what is notnot there is more there is more 
interesting than what interesting than what isis therethere

Identify missing Registry keysIdentify missing Registry keys

Search for status Search for status ““NOTFOUNDNOTFOUND””

May reveal hidden capabilitiesMay reveal hidden capabilities
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Filemon/Regmon as a ServiceFilemon/Regmon as a Service
Sometimes need to capture I/O or registry Sometimes need to capture I/O or registry 
activity activity duringduring the logon or logoff processthe logon or logoff process

E.g. errors occurring during logon/logoffE.g. errors occurring during logon/logoff
Solutions:Solutions:

Install and run Filemon/Regmon as a service using Install and run Filemon/Regmon as a service using 
SrvanySrvany tool in Resource Kittool in Resource Kit

Can configure to start at system bootCan configure to start at system boot

For a quick, oneFor a quick, one--time execution, run time execution, run 
Filemon/Regmon with Filemon/Regmon with ““psexecpsexec ––s s ––ii””

In either case, but tools remain running after In either case, but tools remain running after 
logofflogoff
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End of Part 3End of Part 3

Next: Crash Dump AnalysisNext: Crash Dump Analysis
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IntroductionIntroduction
Many systems administrators never attempt crash dump Many systems administrators never attempt crash dump 
analysisanalysis

““I donI don’’t know what to do with onet know what to do with one”…“”…“Its too hardIts too hard”…”…..““It wonIt won’’t tell me t tell me 
anything anywayanything anyway”…”…

Basic crash dump analysis is actually pretty straightforwardBasic crash dump analysis is actually pretty straightforward
Even if only 1 out of 5 or 10 dumps tells you whatEven if only 1 out of 5 or 10 dumps tells you what’’s wrong, isns wrong, isn’’t it t it 
worth spending a few minutes?worth spending a few minutes?

More advanced crash dump analysis much harderMore advanced crash dump analysis much harder
Not well documentedNot well documented

Requires advanced internals knowledgeRequires advanced internals knowledge

Often difficult to pinpoint causeOften difficult to pinpoint cause
More often than not, victim is often not the culpritMore often than not, victim is often not the culprit

e.g. a driver corrupts an operating system structure; NT crashese.g. a driver corrupts an operating system structure; NT crashes laterlater

4-4

Why Does Windows Crash?Why Does Windows Crash?
Top 100 Reported Crashing Issues (reported at Top 100 Reported Crashing Issues (reported at WinHECWinHEC
2004 conference)2004 conference)

~70% caused by 3rd party driver code~70% caused by 3rd party driver code

~15% caused by unknown (memory is too corrupted to tell)~15% caused by unknown (memory is too corrupted to tell)

~10% caused by hardware issues~10% caused by hardware issues

~5% caused by Microsoft code~5% caused by Microsoft code

There are lots of third party drivers!There are lots of third party drivers!
From online crash analysis database:From online crash analysis database:

28,000 unique drivers on XP (9 new / day)28,000 unique drivers on XP (9 new / day)

130,000 total drivers seen on XP (88 revised / day)130,000 total drivers seen on XP (88 revised / day)

Many DevicesMany Devices
Over 680,000 distinct Plug and Play (PnP) IDsOver 680,000 distinct Plug and Play (PnP) IDs

1,600 PnP IDs added every day1,600 PnP IDs added every day
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Blue ScreensBlue Screens
The kernel and all drivers are The kernel and all drivers are ““trustedtrusted”” and share the and share the 
system address spacesystem address space

Any driver or the kernel can cause corruption or an illegal Any driver or the kernel can cause corruption or an illegal 
operationoperation
Many illegal actions can go undetected for long periods of timeMany illegal actions can go undetected for long periods of time

What causes crashes?What causes crashes?
Something in kernelSomething in kernel--mode detects a problem and calls mode detects a problem and calls 
KeBugCheckExKeBugCheckEx
UserUser--mode applications cannot directly cause a crashmode applications cannot directly cause a crash

4-6

What Happens At The CrashWhat Happens At The Crash

When a condition is detected that requires a crash, When a condition is detected that requires a crash, 
KeBugCheckExKeBugCheckEx is calledis called

Takes five arguments:Takes five arguments:
Stop code (also called Stop code (also called bugcheckbugcheck code)code)

4 stop4 stop--code defined parameterscode defined parameters

KeBugCheckExKeBugCheckEx::
Turns off interruptsTurns off interrupts

Tells other CPUs to stopTells other CPUs to stop

Paints the blue screenPaints the blue screen

Notifies registered drivers of the crashNotifies registered drivers of the crash

If a dump is configured (and it is safe to do so), writes dump tIf a dump is configured (and it is safe to do so), writes dump to disko disk
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Crash Dumps OptionsCrash Dumps Options
Small Memory Dump (Small Memory Dump (akaaka minidumpminidump))

Default for Windows 2000/XP Default for Windows 2000/XP 
Professional/HomeProfessional/Home
Only 64kb (128kb on 64Only 64kb (128kb on 64--bit systems)bit systems)
Contains minimal crash informationContains minimal crash information
Creates a unique file name in Creates a unique file name in 
\\WindowsWindows\\MinidumpMinidump after rebootafter reboot

KernelKernel
Writes OS memory and not processesWrites OS memory and not processes

most crash debugging doesnmost crash debugging doesn’’t involve t involve 
looking at process memory anywaylooking at process memory anyway

Useful for large memory systemsUseful for large memory systems
Overwrites every timeOverwrites every time

FullFull
Default for ServerDefault for Server
Writes all of RAMWrites all of RAM
Overwrites every timeOverwrites every time

4-9

MinidumpsMinidumps

On Windows XP and Windows Server 2003, On Windows XP and Windows Server 2003, minidumpminidump is is 
always created, even if system set to full or kernel dumpalways created, even if system set to full or kernel dump

Can extract a Can extract a minidumpminidump from a kernel or full dump using from a kernel or full dump using 
the debugger the debugger ““.dump /m.dump /m”” commandcommand

To analyze, requires access to the images on the To analyze, requires access to the images on the 
system that crashedsystem that crashed

At least must have At least must have havehave access to the access to the Ntoskrnl.exeNtoskrnl.exe

Microsoft Symbol Server now has images for Windows XP and Microsoft Symbol Server now has images for Windows XP and 
laterlater

Set image path to same as symbol path (covered later)Set image path to same as symbol path (covered later)
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Writing a Crash DumpWriting a Crash Dump
Crash dumps are written to the paging fileCrash dumps are written to the paging file

Too risky to try and create a new file (no guarantee you Too risky to try and create a new file (no guarantee you 
will get a dump anyway)will get a dump anyway)

How is even this protected?How is even this protected?
When the system boots it checks When the system boots it checks 
HKEY_LOCAL_MACHINEHKEY_LOCAL_MACHINE\\SystemSystem\\
CurrentControlSetCurrentControlSet\\ControlControl\\CrashControlCrashControl
The The boot diskboot disk paging filepaging file’’s ons on--disk mapping is obtaineddisk mapping is obtained
Relevant components are Relevant components are checksummedchecksummed::

Boot disk miniport driverBoot disk miniport driver
Crash I/O functionsCrash I/O functions
Page file mapPage file map

On crash, if checksum doesnOn crash, if checksum doesn’’t match, dump is not t match, dump is not 
writtenwritten

4-11

At The RebootAt The Reboot

SessionSession
ManagerManager

NtCreatePagingFileNtCreatePagingFile
PagingPaging

FileFile

Memory.dmpMemory.dmp

WinLogonWinLogon

SaveDumpSaveDump

User modeUser mode
Kernel modeKernel mode

11
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44
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At The RebootAt The Reboot

Session Manager process (Session Manager process (\\WindowsWindows\\system32system32\\smss.exe) initializes smss.exe) initializes 
paging filepaging file

NtCreatePagingFileNtCreatePagingFile

NtCreatePagingFileNtCreatePagingFile determines if the dump has a crash headerdetermines if the dump has a crash header
Protects the dump from useProtects the dump from use

Note: crash dump portion of paging file is in use during the copNote: crash dump portion of paging file is in use during the copy, so virtual y, so virtual 
memory can run low while the copy is in progressmemory can run low while the copy is in progress

WinLogonWinLogon calls calls NtQuerySystemInformationNtQuerySystemInformation to tell if thereto tell if there’’s a dump to s a dump to 
extractextract

If thereIf there’’s a dump, s a dump, WinlogonWinlogon executes executes SaveDumpSaveDump
((\\WindowsWindows\\system32system32\\savedump.exe)savedump.exe)

Writes an event to the System event logWrites an event to the System event log

SaveDumpSaveDump writes contents to appropriate filewrites contents to appropriate file

On XP or later, checks to see if Windows Error Reporting should On XP or later, checks to see if Windows Error Reporting should be be 
invokedinvoked

11

22

33
44
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Why Would You Not Get A Dump?Why Would You Not Get A Dump?

Most common reasons:Most common reasons:
Crash occurred before paging file was openCrash occurred before paging file was open

E.g. a crash during driver initializationE.g. a crash during driver initialization

Paging file on boot volume is too smallPaging file on boot volume is too small

Not enough free space for extracted dumpNot enough free space for extracted dump

Less common:Less common:
The crash corrupted components involved in the dump processThe crash corrupted components involved in the dump process

Miniport driver doesnMiniport driver doesn’’t implement dump I/O functionst implement dump I/O functions
Windows 2000 and beyond storage drivers must implement dump I/O Windows 2000 and beyond storage drivers must implement dump I/O 
to get a Microsoftto get a Microsoft®® signaturesignature

How do you troubleshoot a system that is crashing with no How do you troubleshoot a system that is crashing with no 
resulting dump?resulting dump?

Covered laterCovered later……
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Online Crash Analysis (OCA)Online Crash Analysis (OCA)

By Default, after a reboot By Default, after a reboot 
XP/Server 2003 prompts you to XP/Server 2003 prompts you to 
send information to send information to 
http://watson.microsoft.comhttp://watson.microsoft.com

Can be configured with Computer Can be configured with Computer 
PropertiesProperties-->Advanced>Advanced-->Error >Error 
ReportingReporting

Can be customized with Group Can be customized with Group 
PoliciesPolicies

Do/do not show UIDo/do not show UI

Send dump to an internal error Send dump to an internal error 
reporting serverreporting server

4-15

Windows Error Reporting InternalsWindows Error Reporting Internals
SavedumpSavedump checks if kernel error reporting is enabledchecks if kernel error reporting is enabled

Checks two values under Checks two values under 
HKLMHKLM\\SoftwareSoftware\\MicrosoftMicrosoft\\PCHealthPCHealth\\ErrorReportingErrorReporting: : IncludeKernelFaultsIncludeKernelFaults
and and DoReportDoReport

If crash reporting is enabled, If crash reporting is enabled, SavedumpSavedump::
Extracts a Extracts a minidumpminidump from the dump file (if system set to full or kernel from the dump file (if system set to full or kernel 
dumps)dumps)

Writes the name of the Writes the name of the minidumpminidump under under 
HKLMHKLM\\SoftwareSoftware\\MicrosoftMicrosoft\\PCHealthPCHealth\\ErrorReportingErrorReporting\\KernelFaultsKernelFaults

Adds a command to execute Adds a command to execute Dumprep.exeDumprep.exe to to 
HKLMHKLM\\SoftwareSoftware\\MicrosoftMicrosoft\\WindowsWindows\\CurrentVersionCurrentVersion\\Run Run 

This will cause it to run at the first user log onThis will cause it to run at the first user log on

DumpprepDumpprep then:then:
Generates an XML description of system version, drivers present,Generates an XML description of system version, drivers present, loaded loaded 
plug and play drivers and depending on the configurationplug and play drivers and depending on the configuration

Displays the message box (if enabled) to send the dumpDisplays the message box (if enabled) to send the dump

Submits to dump for automatic analysisSubmits to dump for automatic analysis
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What Gets SentWhat Gets Sent
<?xml version="1.0" encoding="Unicode" ?>

<SYSTEMINFO>

<SYSTEM>

<OSNAME>Microsoft Windows XP 
Professional</OSNAME>

<OSVER>5.1.2477 0.0</OSVER>

<OSLANGUAGE>1033</OSLANGUAGE>

</SYSTEM>

<DRIVERS>

<DRIVER>
<FILENAME>ac97intc.sys</FILENAME>

<FILESIZE>98112</FILESIZE>

<CREATIONDATE>05-17-2001 
06:31:52</CREATIONDATE>

<VERSION>5.10.0.3518</VERSION>

<MANUFACTURER>Intel 
Corporation</MANUFACTURER>

<PRODUCTNAME>

Intel(r) Integrated Controller Hub Audio 
Driver</PRODUCTNAME>

</DRIVER>

1. XML description of system 
version, drivers present, loaded 
plug and play drivers

2. Minidump file (Loaded and 
recently unloaded drivers, basic 
information on current process, 
kernel-mode call stack for the 
interrupted thread, hardware devices 
installed)

4-17

What Does OCA Do?What Does OCA Do?

Server analyzes crash information submittedServer analyzes crash information submitted
If there is a response, displays a link to get more If there is a response, displays a link to get more 
informationinformation

E.g. KB article, hot fix, updated 3E.g. KB article, hot fix, updated 3rdrd party driver, etc.party driver, etc.

If not, you can check back later at If not, you can check back later at oca.microsoft.comoca.microsoft.com

If no solution, you should try and analyze dump If no solution, you should try and analyze dump 
to tell you:to tell you:

What driver to disable, update, or replace with What driver to disable, update, or replace with 
different hardwaredifferent hardware

What OEM to send the dump toWhat OEM to send the dump to
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Manual Crash AnalysisManual Crash Analysis

There are two kernelThere are two kernel--level debuggers that can open level debuggers that can open 
crash dump files:crash dump files:

WinDbgWinDbg ––Windows programWindows program
KdKd –– commandcommand--line programline program
Both provide same kernel debugger analysis commandsBoth provide same kernel debugger analysis commands

Get the latest from:Get the latest from:
http://www.microsoft.com/whdc/DevTools/Debugging/defhttp://www.microsoft.com/whdc/DevTools/Debugging/def
ault.mspxault.mspx

Supports Windows NT 4, Windows 2000, Windows XP, Supports Windows NT 4, Windows 2000, Windows XP, 
Windows Server 2003 (32Windows Server 2003 (32--bit and 64bit and 64--bit)bit)
Check for updates frequentlyCheck for updates frequently
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Manual Crash AnalysisManual Crash Analysis
Open the crash dump with Open the crash dump with WindbgWindbg

When you open a crash dump with When you open a crash dump with WindbgWindbg or or KdKd you you 
get a basic crash analysis:get a basic crash analysis:

Stop code and parametersStop code and parameters

A guess at offending driverA guess at offending driver

The analysis is the result of the automated execution of The analysis is the result of the automated execution of 
the !analyze debugger commandthe !analyze debugger command

!analyze uses heuristics to determine what the likely !analyze uses heuristics to determine what the likely 
cause of the crash iscause of the crash is

Debugger tells you to type Debugger tells you to type ““!analyze !analyze ––vv”” to get to get 
detailed debugging informationdetailed debugging information

Explains the Explains the bugcheckbugcheck codecode

Interprets the Interprets the bugcheckbugcheck parametersparameters
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Symbol FilesSymbol Files

In order to analyze a crash dump, Debugger needs access In order to analyze a crash dump, Debugger needs access 
to (at least) the symbol file for to (at least) the symbol file for Ntoskrnl.exeNtoskrnl.exe

Symbol files contain global function and variable namesSymbol files contain global function and variable names

Easiest to use Microsoft Symbol Server for symbol accessEasiest to use Microsoft Symbol Server for symbol access
WindbgWindbg: click on File: click on File-->Symbol File Path>Symbol File Path
Enter Enter ““srvsrv*c:*c:\\symbols*http://symbols*http://msdl.microsoft.commsdl.microsoft.com/download/symbols/download/symbols””

If a If a minidumpminidump, must also configure image path to point to , must also configure image path to point to 
location of images (Filelocation of images (File-->Image File Path)>Image File Path)

Use same string as for symbol server (XP and beyond)Use same string as for symbol server (XP and beyond)
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OutlineOutline
Crash dumps and toolsCrash dumps and tools
Analysis basicsAnalysis basics

IRQLsIRQLs
StacksStacks

Analyzing an Analyzing an ““easyeasy”” crashcrash
UnUn--Analyzable crashesAnalyzable crashes

Crash transformationCrash transformation
Buffer overrunBuffer overrun
Code overwriteCode overwrite

Manual analysisManual analysis
Hung SystemsHung Systems
When there is no crash dumpWhen there is no crash dump
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IRQLsIRQLs

IRQL stands for Interrupt Request LevelIRQL stands for Interrupt Request Level
Each CPU maintains IRQL independentlyEach CPU maintains IRQL independently
Software and hardware interrupts map to Software and hardware interrupts map to IRQLsIRQLs
When a CPU raises its IRQL to a level all interrupts at that levWhen a CPU raises its IRQL to a level all interrupts at that level el 
and below are masked for that CPUand below are masked for that CPU

SYNCH_LEVELSYNCH_LEVEL

DEVICE_IRQL 2DEVICE_IRQL 2
DEVICE_IRQL 1DEVICE_IRQL 1

APC_LEVELAPC_LEVEL
PASSIVE_LEVELPASSIVE_LEVEL

DISPATCH_LEVELDISPATCH_LEVEL

::
::
::

MaskedMasked

UnmaskedUnmaskedHardwareHardware
InterruptsInterrupts

SoftwareSoftware
InterruptsInterrupts

Current IRQLCurrent IRQL

4-23

Key Key IRQLsIRQLs

PASSIVE_LEVEL:PASSIVE_LEVEL:
No interrupts are maskedNo interrupts are masked
User mode code always executes at PASSIVE_LEVELUser mode code always executes at PASSIVE_LEVEL
KernelKernel--mode code executes at PASSIVE_LEVEL most of the mode code executes at PASSIVE_LEVEL most of the 
timetime

DISPATCH_LEVEL: DISPATCH_LEVEL: 
Highest software interrupt levelHighest software interrupt level
Scheduler is offScheduler is off
Page faults cannot be handled and are illegal operationsPage faults cannot be handled and are illegal operations
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StacksStacks
The stack is the #1 analysis resourceThe stack is the #1 analysis resource

It requires that a driver get It requires that a driver get ““caught in the actcaught in the act””
Sometimes thatSometimes that’’s not possible without the Driver Verifiers not possible without the Driver Verifier’’s helps help

Each thread has a userEach thread has a user--mode and kernelmode and kernel--mode stackmode stack
The userThe user--mode stack is usually 1 MB on x86mode stack is usually 1 MB on x86
The kernelThe kernel--mode stack is typically 12 KB on x86 systemsmode stack is typically 12 KB on x86 systems

Stacks allow for nested function invocationStacks allow for nested function invocation
Parameters can be passed on the stackParameters can be passed on the stack
Stores return addressStores return address
Serves as storage for local variablesServes as storage for local variables
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OutlineOutline
Crash dumps and toolsCrash dumps and tools
Analysis basicsAnalysis basics

IRQLsIRQLs
StacksStacks

Analyzing an Analyzing an ““easyeasy”” crashcrash
UnUn--Analyzable crashesAnalyzable crashes

Crash transformationCrash transformation
Buffer overrunBuffer overrun
Code overwriteCode overwrite

Manual analysisManual analysis
Hung SystemsHung Systems
When there is no crash dumpWhen there is no crash dump
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NotMyFault.exeNotMyFault.exe
Test program and driver to Test program and driver to 
demonstrate common crash demonstrate common crash 
scenariosscenarios

It loads It loads MyFault.sysMyFault.sys

MyFault.SysMyFault.Sys has an IOCTL has an IOCTL 
interface that implements interface that implements 
different bugsdifferent bugs

Get it at:Get it at:
http://http://www.sysinternals.comwww.sysinternals.com

/files//files/notmyfault.zipnotmyfault.zip

MyFault.sysMyFault.sys
IOCTL InterfaceIOCTL Interface

User ModeUser Mode
Kernel ModeKernel Mode

4-29

Generating a StraightGenerating a Straight--Forward CrashForward Crash
Run Run NotMyFaultNotMyFault and select and select ““High IRQL fault (kernel High IRQL fault (kernel 
mode)mode)””

Allocates paged pool bufferAllocates paged pool buffer
Frees the bufferFrees the buffer
Raises IRQL Raises IRQL ≥≥ DISPATCH_LEVELDISPATCH_LEVEL
Touches the bufferTouches the buffer

Paged buffers that are marked Paged buffers that are marked ““not presentnot present”” but are but are 
touched when IRQL touched when IRQL ≥≥ DISPATCH_LEVEL result in the DISPATCH_LEVEL result in the 
DRIVER_IRQL_NOT_LESS_OR_EQUAL bug checkDRIVER_IRQL_NOT_LESS_OR_EQUAL bug check

Page fault handler calls Page fault handler calls KeBugCheckExKeBugCheckEx from page fault from page fault 
handlerhandler
The IRQL is not less than or equal to the maximum IRQL at The IRQL is not less than or equal to the maximum IRQL at 
which the operation is legal (which is < DISPATCH_LEVEL)which the operation is legal (which is < DISPATCH_LEVEL)
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High IRQL Fault AnalysisHigh IRQL Fault Analysis

!analyze says !analyze says ““memory corruptionmemory corruption””

!analyze !analyze ––v easily identifies v easily identifies MyFault.sysMyFault.sys by by 
looking at the looking at the KeBugCheckExKeBugCheckEx parametersparameters

Displays the faulting IP in Displays the faulting IP in Myfault.sysMyfault.sys
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OutlineOutline
Crash dumps and toolsCrash dumps and tools
Analysis basicsAnalysis basics

IRQLsIRQLs
StacksStacks

Analyzing an Analyzing an ““easyeasy”” crashcrash
UnUn--Analyzable crashesAnalyzable crashes

Crash transformationCrash transformation
Buffer overrunBuffer overrun
Code overwriteCode overwrite

Manual analysisManual analysis
Hung SystemsHung Systems
When there is no crash dumpWhen there is no crash dump



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

4-32

Crash TransformationCrash Transformation

Many crashes canMany crashes can’’t be analyzedt be analyzed
The The ““victimvictim”” crashed the system, not the criminalcrashed the system, not the criminal

The analyzer may point at The analyzer may point at Ntoskrnl.exeNtoskrnl.exe or or 
Win32K.sys or other Windows componentsWin32K.sys or other Windows components

Or, you may get many different crash dumps all Or, you may get many different crash dumps all 
pointing at different causespointing at different causes

YouYou’’re goal isnre goal isn’’t to analyze impossible t to analyze impossible 
crashescrashes……

Its to try to make an Its to try to make an ““unanalyzableunanalyzable”” crash into one crash into one 
that can be analyzedthat can be analyzed
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Crash Transformation RecipeCrash Transformation Recipe
The tool for crash The tool for crash 
transformation is the Driver transformation is the Driver 
Verifier (Verifier (Verifier.exeVerifier.exe –– not in not in 
Start menu)Start menu)

Introduced in Windows 2000Introduced in Windows 2000
Helps developers test their Helps developers test their 
drivers and systems drivers and systems 
administrators identify faulty administrators identify faulty 
driversdrivers

Run Run Verifier.exeVerifier.exe
Choose Choose ““Create Custom Create Custom 
SettingsSettings””
Choose Choose ““Select Individual Select Individual 
Settings from a ListSettings from a List””
Enable all options except Low Enable all options except Low 
Resource SimulationResource Simulation
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Using Driver VerifierUsing Driver Verifier

Then, need to decide which drivers to verifierThen, need to decide which drivers to verifier
1.1. First, try any First, try any ““suspicioussuspicious”” drivers (recently updated, drivers (recently updated, 

known to be problematic, etc)known to be problematic, etc)

2.2. If no crash, try enabling verification on all 3If no crash, try enabling verification on all 3rdrd party party 
drivers and/or all unsigned driversdrivers and/or all unsigned drivers

3.3. If still no crash, enable verification on all driversIf still no crash, enable verification on all drivers
May significantly slow down your systemMay significantly slow down your system
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UnUn--Analyzable Crash: Analyzable Crash: 
Buffer OverrunBuffer Overrun

Result when a driver goes past the end (overrun) or the Result when a driver goes past the end (overrun) or the 
beginning (beginning (underrununderrun) of a buffer) of a buffer
Usually detected whenUsually detected when
overwritten data is overwritten data is 
referencedreferenced

Another driver or the Another driver or the 
kernel makes the referencekernel makes the reference
There can be a long delayThere can be a long delay
between corruption and between corruption and 
detectiondetection Driver BufferDriver Buffer

Another DriverAnother Driver’’s Buffers Buffer

Pool StructuresPool Structures

HigherHigher
AddressesAddresses
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Causing a Buffer OverrunCausing a Buffer Overrun

Run Run NotMyFaultNotMyFault and select and select ““Buffer OverrunBuffer Overrun””
Allocates a Allocates a nonpagednonpaged pool bufferpool buffer

Writes a string past the endWrites a string past the end

Note that you might have to run several times since a Note that you might have to run several times since a 
crash will occur only if:crash will occur only if:

The kernel references the corrupted pool structures The kernel references the corrupted pool structures 

A driver references the corrupted bufferA driver references the corrupted buffer

The crash tells you what happened, but not whyThe crash tells you what happened, but not why
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A Buffer Overrun A Buffer Overrun BluescreenBluescreen
In this example, where the crash was the result of the kernel trIn this example, where the crash was the result of the kernel tripping ipping 
on corrupt pool tracking structures, the on corrupt pool tracking structures, the BluescreenBluescreen tells you what to do:tells you what to do:
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What is Special Pool?What is Special Pool?

Special pool is a kernel buffer area Special pool is a kernel buffer area 
where buffers are sandwiched with where buffers are sandwiched with 
invalid pagesinvalid pages

Conditions for a driver allocating from Conditions for a driver allocating from 
special pool:special pool:

Driver Verifier is verifying driverDriver Verifier is verifying driver

Special pool is enabledSpecial pool is enabled

Allocation is slightly less than one Allocation is slightly less than one 
page (4 KB on x86)page (4 KB on x86)

InvalidInvalid

InvalidInvalid

BufferBuffer

SignatureSignature

HigherHigher
AddressesAddresses

Page nPage n

Page n+1Page n+1

Page n+2Page n+2
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Turning on Special PoolTurning on Special Pool
You get Special Pool when you enable the Verifier You get Special Pool when you enable the Verifier 
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The Verifier Catching Buffer OverrunThe Verifier Catching Buffer Overrun

The Driver Verifier catches the overrun when it occursThe Driver Verifier catches the overrun when it occurs
The blue screen tells you whoThe blue screen tells you who’’s fault it iss fault it is

!analyze explains the crash and also tells you the buggy driver !analyze explains the crash and also tells you the buggy driver 
namename

The stack shows where the driver bug isThe stack shows where the driver bug is
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UnUn--Analyzable Crash: Analyzable Crash: 
Code OverwriteCode Overwrite

Caused when a bug results in a wild pointerCaused when a bug results in a wild pointer
A wild pointer that points at invalid memory is easily detectedA wild pointer that points at invalid memory is easily detected
A wild pointer that points at data is similar to buffer overrunA wild pointer that points at data is similar to buffer overrun

Might not cause a problem for a long timeMight not cause a problem for a long time
Crash makes it look like its something elseCrash makes it look like its something else’’s faults fault

System code write protection catches code overwrite, but System code write protection catches code overwrite, but 
itit’’s not on if:s not on if:

ItIt’’s a Windows 2000 system with > 127 MB memorys a Windows 2000 system with > 127 MB memory
ItIt’’s a Windows XP or Server 2003 system with > 255 MBs a Windows XP or Server 2003 system with > 255 MB
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Causing a Code OverwriteCausing a Code Overwrite

Run Run NotMyFaultNotMyFault and select and select ““Code OverwriteCode Overwrite””
Overwrites first bytes of Overwrites first bytes of nt!ntreadfilent!ntreadfile

Function is most common entry to I/O system so a random thread wFunction is most common entry to I/O system so a random thread will ill 
cause the crashcause the crash

The crash hints that the fault occurred in The crash hints that the fault occurred in NtReadFileNtReadFile
The last userThe last user--mode address is mode address is ZwReadFileZwReadFile

The The ebxebx register in the exception frame points at register in the exception frame points at NtReadFileNtReadFile

NtReadFileNtReadFile’’ss start location looks scrambled (u start location looks scrambled (u ntreadfilentreadfile))
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System Code Write ProtectionSystem Code Write Protection
If at least one driver is being verified then system code write If at least one driver is being verified then system code write protection protection 
is enabledis enabled

You can also enable it manually:You can also enable it manually:
Set HKLMSet HKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\ControlControl

\\Session ManagerSession Manager\\Memory ManagementMemory Management

LargePageMinimumLargePageMinimum REG_DWORD REG_DWORD 0xFFFFFFFF0xFFFFFFFF
EnforceWriteProtectionEnforceWriteProtection REG_DWORD 1REG_DWORD 1

Reboot to take effectReboot to take effect

Rerun Rerun NotMyFaultNotMyFault
Crash occurs immediately and even the blue screen points at Crash occurs immediately and even the blue screen points at 
MyFault.sysMyFault.sys::

!analyze shows the address of the write and the target (!analyze shows the address of the write and the target (NtReadFileNtReadFile))
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OutlineOutline
Crash dumps and toolsCrash dumps and tools
Analysis basicsAnalysis basics

IRQLsIRQLs
StacksStacks

Analyzing an Analyzing an ““easyeasy”” crashcrash
UnUn--Analyzable crashesAnalyzable crashes

Crash transformationCrash transformation
Buffer overrunBuffer overrun
Code overwriteCode overwrite

Manual analysisManual analysis
Hung SystemsHung Systems
When there is no crash dumpWhen there is no crash dump
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Manual AnalysisManual Analysis
Sometimes !analyze Sometimes !analyze ––v isnv isn’’t enought enough

DoesnDoesn’’t tell you anything usefult tell you anything useful
You want to know what was happening at the time of the crashYou want to know what was happening at the time of the crash

Useful commands:Useful commands:
List loaded drivers: lm List loaded drivers: lm kvkv

Make sure drivers are all recognized and up to dateMake sure drivers are all recognized and up to date
Look at memory usage: !Look at memory usage: !vmvm

Make sure memory pools are not fullMake sure memory pools are not full
If full, use !If full, use !poolusedpoolused (requires pool tagging to be on)(requires pool tagging to be on)

Examine current thread: !threadExamine current thread: !thread
May or may not be related to the crashMay or may not be related to the crash

List all processes: !process 0 0List all processes: !process 0 0
Make sure you understand what was running on the systemMake sure you understand what was running on the system

If a Verifier detected deadlock: !deadlockIf a Verifier detected deadlock: !deadlock
Additional commands: !helpAdditional commands: !help
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Analyzing a Analyzing a ““SickSick”” SystemSystem

Sometimes a system is still responsive, but you Sometimes a system is still responsive, but you 
know that something is wrong with itknow that something is wrong with it

You want to look at its kernel state, butYou want to look at its kernel state, but……

You donYou don’’t want to take it off line by crashing it or t want to take it off line by crashing it or 
connecting a debugger to itconnecting a debugger to it

You can get a You can get a ““dumpdump”” of a live system with of a live system with 
LiveKdLiveKd (free download from (free download from Sysinternals.comSysinternals.com))

Use it to run Use it to run WindbgWindbg or or KdKd

Use .dump to snapshot live systemUse .dump to snapshot live system
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Hung SystemsHung Systems

ScenerioScenerio: : ““hard hangshard hangs”” (e.g. no keyboard or (e.g. no keyboard or 
mouse response)mouse response)
Two techniques: both require prior setup and a Two techniques: both require prior setup and a 
rebootreboot
1.1. Manually crash the hung system and hope you get a Manually crash the hung system and hope you get a 

dump to analyze offlinedump to analyze offline
2.2. Boot the system in debugging mode and when it Boot the system in debugging mode and when it 

hangs, break in with the kernel debugger and hangs, break in with the kernel debugger and 
analyze systemanalyze system
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Crashing Hung SystemsCrashing Hung Systems
Set the keystroke crash optionSet the keystroke crash option

Set Set HKEY_LOCAL_MACHINEHKEY_LOCAL_MACHINE\\SystemSystem\\
CurrentControlSetCurrentControlSet\\ServicesServices\\i8042prti8042prt\\
ParametersParameters\\CrashOnCtrlScrollCrashOnCtrlScroll to 1to 1
RebootReboot

Rerun Rerun NotMyFaultNotMyFault
Enter rightEnter right--ctrl+[scrollctrl+[scroll--lock, scrolllock, scroll--lock] to crash the system lock] to crash the system 

!analyze won!analyze won’’t helpt help
Use !thread to see whatUse !thread to see what’’s runnings running

Use ~ command to look at each CPUUse ~ command to look at each CPU
One CPU is executing One CPU is executing MyFaultMyFault code grabbing a spinlockcode grabbing a spinlock

Spinlock hangs are much easier to debug than dispatcher object Spinlock hangs are much easier to debug than dispatcher object 
(events, semaphores, (events, semaphores, mutexesmutexes) and resource hangs) and resource hangs
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Booting in Debugging ModeBooting in Debugging Mode
If you have hangs or crashes with no resulting dump (or other If you have hangs or crashes with no resulting dump (or other 
““spontaneous rebootsspontaneous reboots””))

……you need to get into the kernel debugger at the time of the crasyou need to get into the kernel debugger at the time of the crashh

Boot in Debugging ModeBoot in Debugging Mode
Two options to boot in debugging mode:Two options to boot in debugging mode:

1.1. Press F8 during the boot and choose Press F8 during the boot and choose ““Debugging ModeDebugging Mode””

2.2. Or, edit the targetOr, edit the target’’s s boot.iniboot.ini file to configure:file to configure:
//debugportdebugport==comXcomX //baudratebaudrate=XXX   (note: default baud rate in Debugging =XXX   (note: default baud rate in Debugging 
Mode is 19200)Mode is 19200)

Windows XP and 2003 support 1394Windows XP and 2003 support 1394

In either case, this loads the kernel debugger at boot timeIn either case, this loads the kernel debugger at boot time
Does not affect performanceDoes not affect performance

But, system will not auto reboot after a crash, even if configurBut, system will not auto reboot after a crash, even if configured to do ed to do 
so!so!
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Debugging System in Debugging ModeDebugging System in Debugging Mode

When system hangs or crashes, attach a kernel debugger When system hangs or crashes, attach a kernel debugger 
and analyzeand analyze

In In WindbgWindbg, choose File, choose File-->Kernel Debug>Kernel Debug
Configure baud rate and COM portConfigure baud rate and COM port

Click OKClick OK

If a crash, Debugger should connect and display the If a crash, Debugger should connect and display the 
bugcheckbugcheck codecode

If a hung system, must break in with If a hung system, must break in with ““DebugDebug-->Break>Break””

Type !analyze Type !analyze ––v and/or perform manual analysis v and/or perform manual analysis 
commands described earliercommands described earlier

To save complete memory dump for offline analysis, use To save complete memory dump for offline analysis, use ““.dump.dump””
(or (or ““.dump /f.dump /f”” to capture a full dump)to capture a full dump)

Note: this will be slow over a serial cableNote: this will be slow over a serial cable
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End of Part 3End of Part 3

For more information:For more information:
Windows Internals: Chapter 14 is on crash dump analysisWindows Internals: Chapter 14 is on crash dump analysis

The help file which is installed with Debugging Tools for WindowThe help file which is installed with Debugging Tools for Windowss

Next: Boot & Startup TroubleshootingNext: Boot & Startup Troubleshooting
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OutlineOutline
1.1. Process & Thread TroubleshootingProcess & Thread Troubleshooting

2.2. Understanding & Troubleshooting Memory Understanding & Troubleshooting Memory 
ProblemsProblems

3.3. Troubleshooting with Troubleshooting with FilemonFilemon & & RegmonRegmon

4.4. Crash Dump AnalysisCrash Dump Analysis

5.5. Boot & Startup TroubleshootingBoot & Startup Troubleshooting

5-2

IntroductionIntroduction
Kinds of problems we're addressing:Kinds of problems we're addressing:

Error messages during bootError messages during boot
Crashes and hangs during bootCrashes and hangs during boot
Errors messages during the logon processErrors messages during the logon process

Typical causes:Typical causes:
3rd party drivers and applications3rd party drivers and applications
System file corruption due to hardware problems or blue System file corruption due to hardware problems or blue 
screens (from 3rd party drivers)screens (from 3rd party drivers)
MalwareMalware, viruses, viruses……

CommonCommon response: "Reinstall Windows"response: "Reinstall Windows"
You can do better than that by understanding the boot and You can do better than that by understanding the boot and 
startup process and the tools available to track down and startup process and the tools available to track down and 
repair problemsrepair problems
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
System file corruptionSystem file corruption
Crashes or hangs Crashes or hangs 
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Boot Process TerminologyBoot Process Terminology

Boot begins during installation when Setup writes Boot begins during installation when Setup writes 
various things to diskvarious things to disk

System volume:System volume:
Master Boot Record (MBR)Master Boot Record (MBR)

Boot sectorBoot sector

NTLDR NTLDR –– NT Boot LoaderNT Boot Loader

NTDETECT.COMNTDETECT.COM

BOOT.INIBOOT.INI

SCSI driver SCSI driver –– Ntbootdd.sysNtbootdd.sys

Boot volume:Boot volume:
System files System files –– %%SystemRootSystemRoot%: %: Ntoskrnl.exeNtoskrnl.exe, , Hal.dllHal.dll, etc., etc.
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The Boot ProcessThe Boot Process
1.1. MBRMBR

Contains small amount of code that scans partition tableContains small amount of code that scans partition table
4 entries4 entries

First partition marked active is selected as the system volumeFirst partition marked active is selected as the system volume

Loads boot sector of system volumeLoads boot sector of system volume

2.2. Boot sector (NTBoot sector (NT--specific code)specific code)
Reads root directory of volume and loads NTLDRReads root directory of volume and loads NTLDR

C:

5-6

x86 and x64 Boot Processx86 and x64 Boot Process
3.3. NTLDR (screen is black)NTLDR (screen is black)

Moves system from 16Moves system from 16--bit to 32bit to 32--bit mode and enables pagingbit mode and enables paging
Reads and uses Reads and uses Ntbootdd.sysNtbootdd.sys to perform disk I/O if the boot to perform disk I/O if the boot 
volume is on a SCSI diskvolume is on a SCSI disk

Uses BIOS to read from system volumeUses BIOS to read from system volume’’s disks disk
This is a copy of the SCSI miniport driver used when the OS is This is a copy of the SCSI miniport driver used when the OS is 
bootedbooted

Reads Reads Boot.iniBoot.ini
Boot.iniBoot.ini selections point to boot driveselections point to boot drive
Specifies OS boot selections and optional switches (most for Specifies OS boot selections and optional switches (most for 
debugging/troubleshooting) that passed to kernel during bootdebugging/troubleshooting) that passed to kernel during boot

If more than one selection, NTLDR displays boot menu (with If more than one selection, NTLDR displays boot menu (with 
timeout)timeout)
If you select a 64If you select a 64--bit installation, NTLDR moves the CPU into bit installation, NTLDR moves the CPU into 
6464--bit modebit mode
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The Boot Process (cont)The Boot Process (cont)
3.3. NTLDR (cont)NTLDR (cont)

Once boot selection made, user can type F8 to get to special Once boot selection made, user can type F8 to get to special 
boot menuboot menu

Last Known Good, Safe modes, hardware profile, Debugging Last Known Good, Safe modes, hardware profile, Debugging 
modemode

NTLDR executes NTLDR executes Ntdetect.comNtdetect.com to perform BIOS hardware to perform BIOS hardware 
detection (x86 and x64 only)detection (x86 and x64 only)

Later saved into HKLMLater saved into HKLM\\HardwareHardware\\Description  Description  

NTLDR loads the SYSTEM hive (HKLMNTLDR loads the SYSTEM hive (HKLM\\System), boot drivers, System), boot drivers, 
Ntoskrnl.exeNtoskrnl.exe, , Hal.dllHal.dll and transfers control to main entry point of and transfers control to main entry point of 
Ntoskrnl.exeNtoskrnl.exe

Boot driver: critical to boot process (e.g. boot file system driBoot driver: critical to boot process (e.g. boot file system driver)ver)
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The Boot Process (cont)The Boot Process (cont)

4.4. NtoskrnlNtoskrnl (splash screen appears)(splash screen appears)
Initializes kernel subsystems in two phases:Initializes kernel subsystems in two phases:

First phase is object definition (process, thread, driver, First phase is object definition (process, thread, driver, 
etc)etc)
Second builds on the base that the objects provideSecond builds on the base that the objects provide
This is done in the context of a kernelThis is done in the context of a kernel--mode system mode system 
thread that becomes the idle threadthread that becomes the idle thread

I/O Manager starts bootI/O Manager starts boot--start drivers and then start drivers and then 
loads and starts systemloads and starts system--start driversstart drivers
Finally, Finally, NtoskrnlNtoskrnl creates the Session Manager creates the Session Manager 
process (process (\\WindowsWindows\\System32System32\\Smss.exe), the first Smss.exe), the first 
useruser--mode processmode process
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The Boot Process (cont)The Boot Process (cont)

5.5. Smss.exeSmss.exe::
Runs programs specified in Runs programs specified in BootExecuteBootExecute e.g. e.g. autochkautochk, the , the 
native API version of native API version of chkdskchkdsk

Processes Processes ““Delayed move/renameDelayed move/rename”” commandscommands
Used to replace inUsed to replace in--use system files by use system files by hotfixeshotfixes, service packs, , service packs, 
etc.etc.

Get Get PendmovesPendmoves from Sysinternals to see registered commandsfrom Sysinternals to see registered commands

Initializes the paging files and rest of Registry (hives or fileInitializes the paging files and rest of Registry (hives or files)s)

Loads and initializes kernelLoads and initializes kernel--mode part of Win32 subsystem mode part of Win32 subsystem 
(Win32k.sys)(Win32k.sys)

Starts Starts Csrss.exeCsrss.exe (user(user--mode part of Win32 subsystem)mode part of Win32 subsystem)

Starts Starts Winlogon.exeWinlogon.exe

5-11

The Boot Process (cont)The Boot Process (cont)
6.6. Winlogon.exeWinlogon.exe::

Starts LSASS (Local Security Authority)Starts LSASS (Local Security Authority)

Loads GINA (Graphical Identification and Authentication) to Loads GINA (Graphical Identification and Authentication) to 
wait for logonwait for logon

default is default is Msgina.dllMsgina.dll

Starts Starts Services.exeServices.exe (the service controller)(the service controller)

7.7. Services.exeServices.exe starts Win32 services marked as starts Win32 services marked as 
““automaticautomatic”” start start 

Also includes any drivers marked Automatic start (Start value Also includes any drivers marked Automatic start (Start value 
is 2)is 2)

Service startup continues asynchronous to logonsService startup continues asynchronous to logons

End of normal boot processEnd of normal boot process



Windows Internals & Advanced Troubleshooting
Copyright © 2001-2004 David A. Solomon and Mark E. Russinovich

5-12

The Recovery ConsoleThe Recovery Console
Description: Description: 

Simple repairSimple repair--oriented commandoriented command--line environmentline environment
Built on a minimal NT kernelBuilt on a minimal NT kernel
Bootable from Win2K/XP/Server 2003 Setup CDBootable from Win2K/XP/Server 2003 Setup CD

Type Type ““rr”” to repair and then select the installationto repair and then select the installation

Installable onto hard disk (winnt32.exe /Installable onto hard disk (winnt32.exe /cmdconscmdcons))

5-13

The Recovery ConsoleThe Recovery Console

Capabilities:Capabilities:
File commands: rename, move, delete, copyFile commands: rename, move, delete, copy
Service/Driver commands: Service/Driver commands: listsvclistsvc, enable, disable, enable, disable
MBR/Boot sector commands: MBR/Boot sector commands: fixmbrfixmbr, , fixbootfixboot

Limitations:Limitations:
Must Must ““log intolog into”” the system with the Administrator passwordthe system with the Administrator password
Limits on what you can access:Limits on what you can access:

Only access system directory, Only access system directory, \\System Volume Information System Volume Information 
directories, and root of nondirectories, and root of non--removable media removable media 
Can only copy files onto system, not offCan only copy files onto system, not off
You can override these in the Local Security Policy editor You can override these in the Local Security Policy editor 
((secpol.mscsecpol.msc) on the installation when its running) on the installation when its running

No networking, file editing, or registry editingNo networking, file editing, or registry editing
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
System file corruptionSystem file corruption
Crashes or hangs Crashes or hangs 
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MBR CorruptionMBR Corruption
Symptoms:Symptoms:

Hang at a black screen after BIOS executesHang at a black screen after BIOS executes
““Invalid Partition TableInvalid Partition Table””, , ““Error loading operating systemError loading operating system”” or or 
““Missing operating systemMissing operating system”” message on black screenmessage on black screen

Cause: Cause: 
MBR is corrupt MBR is corrupt 

Resolution:Resolution:
Boot into Recovery ConsoleBoot into Recovery Console
Execute the RCExecute the RC’’s s ““fixmbrfixmbr”” commandcommand

If the partition table is corrupt you have to rely on restoring If the partition table is corrupt you have to rely on restoring a a 
backup MBR or use 3backup MBR or use 3rdrd--party disk repair toolsparty disk repair tools
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
System file corruptionSystem file corruption
Crashes or hangs Crashes or hangs 
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Boot Sector CorruptionBoot Sector Corruption
Symptoms:Symptoms:

Black screen hang Black screen hang 
““A disk read error occurredA disk read error occurred””, , ““NTLDR is missingNTLDR is missing”” or or ““NTLDR is NTLDR is 
compressedcompressed”” error message on black screenerror message on black screen

Cause: Cause: 
Boot sector corruptionBoot sector corruption

Troubleshooting:Troubleshooting:
Boot into RC Boot into RC 
Execute Execute ““fixbootfixboot”” commandcommand
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
System file corruptionSystem file corruption
Crashes or hangs Crashes or hangs 
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Boot.iniBoot.ini ProblemsProblems
Symptom:Symptom:

NTOSKRNL complains that boot device is NTOSKRNL complains that boot device is 
inaccessibleinaccessible

Cause:Cause:
Boot.iniBoot.ini is missing or corruptis missing or corrupt
Boot.iniBoot.ini is outis out--ofof--date because a partition has been date because a partition has been 
addedadded
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Boot.iniBoot.ini ProblemsProblems

Troubleshooting:Troubleshooting:
Boot into RCBoot into RC

Run Run BootcfgBootcfg /rebuild/rebuild
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
System file corruptionSystem file corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
Crashes or hangs Crashes or hangs 
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Registry SYSTEM Hive CorruptionRegistry SYSTEM Hive Corruption
Symptom:Symptom:

NTLDR reports that System hive is corruptNTLDR reports that System hive is corrupt

Causes:Causes:
Disk is corruptDisk is corrupt

System hive is corrupted or deletedSystem hive is corrupted or deleted
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Registry SYSTEM Hive CorruptionRegistry SYSTEM Hive Corruption

Troubleshooting:Troubleshooting:
Boot into RCBoot into RC

Run Run ChkdskChkdsk

If no errors, need to get a backup of the SYSTEM hiveIf no errors, need to get a backup of the SYSTEM hive
On XP with System Restore enable, look in On XP with System Restore enable, look in \\System Volume System Volume 
InformationInformation

Go to  Go to  \\__restore{xxx}restore{xxx}\\RPnnnRPnnn\\snapshotsnapshot

Copy _REGISTRY_MACHINE_SOFTWARE to Copy _REGISTRY_MACHINE_SOFTWARE to 
\\WindowsWindows\\System32System32\\ConfigConfig\\SystemSystem

Otherwise, copy from Otherwise, copy from \\WindowsWindows\\RepairRepair
This backup is created by Windows SetupThis backup is created by Windows Setup

Backing up Backing up ““System StateSystem State”” with Windows Backup update the with Windows Backup update the 
Repair directoryRepair directory
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System File CorruptionSystem File Corruption

Symptom:Symptom:
Error message indicating that NTLDR, NTOSKRNL.EXE, Error message indicating that NTLDR, NTOSKRNL.EXE, 
HAL.DLL or other system file is missing or corruptHAL.DLL or other system file is missing or corrupt

Blue screen with corruption messageBlue screen with corruption message
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System File CorruptionSystem File Corruption

Causes: Causes: 
Disk is corruptDisk is corrupt
File is missing or corruptFile is missing or corrupt

Troubleshooting:Troubleshooting:
Boot into RCBoot into RC

Run Run ChkdskChkdsk

If no If no chkdskchkdsk errors obtain clean copy of file and replace fileerrors obtain clean copy of file and replace file
Check in Check in \\WindowsWindows\\System32System32\\DLLCache for backup DLLCache for backup 
If not there, get a replacement from an identical system i.e. frIf not there, get a replacement from an identical system i.e. from om 
same same hotfixhotfix or service packor service pack

If canIf can’’t find replacement use Automated System Recovery t find replacement use Automated System Recovery 
(ASR) or some other disk image restore utility(ASR) or some other disk image restore utility
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AgendaAgenda

The boot processThe boot process
MBR corruptionMBR corruption
Boot sector corruptionBoot sector corruption
Boot.iniBoot.ini misconfigurationmisconfiguration
System file corruptionSystem file corruption
Crashes or hangs Crashes or hangs 
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PostPost--Splash Screen Crash or HangSplash Screen Crash or Hang

Symptoms:Symptoms:
System blue screens on bootSystem blue screens on boot
Hang before logon prompt appearsHang before logon prompt appears
NOTE: If system autoNOTE: If system auto--reboots on crash you wonreboots on crash you won’’t see the blue t see the blue 
screen!screen!

Causes:Causes:
Buggy driverBuggy driver
Registry corruption of nonRegistry corruption of non--System hiveSystem hive

Troubleshooting:Troubleshooting:
Last Known GoodLast Known Good
oror
Safe ModeSafe Mode
oror
RCRC
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Accessing Last Known GoodAccessing Last Known Good
Enable it by pressing F8 and selecting it in the Advanced Enable it by pressing F8 and selecting it in the Advanced 
Options boot menuOptions boot menu
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LKG DescriptionLKG Description

Last Known Good (LKG) Uses backup of registry control Last Known Good (LKG) Uses backup of registry control 
set last used to boot successfullyset last used to boot successfully
A Control Set is core startup configurationA Control Set is core startup configuration

HKLMHKLM\\SystemSystem\\Control00nControl00n
Control set only includes core OS and driver configurationControl set only includes core OS and driver configuration
Control set does Control set does notnot include Software, SAM, Security, or include Software, SAM, Security, or 
UsersUsers
HKLMHKLM\\SystemSystem\\SelectSelect\\Current  points at active Control Set Current  points at active Control Set 
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LKG DescriptionLKG Description
Boot control makes a copy of the control set that booted Boot control makes a copy of the control set that booted 
the systemthe system

Copy is ControlSet00n, where 00n is the next available numberCopy is ControlSet00n, where 00n is the next available number

After a successful boot:After a successful boot:
1. 1. LastKnownGoodLastKnownGood is set to the copyis set to the copy
2.The previous 2.The previous LastKnownGoodLastKnownGood is deleted is deleted 

By default, By default, ““Successful bootSuccessful boot”” is determined whenis determined when
All the autoAll the auto--start services have started successfullystart services have started successfully
A successful interactive log inA successful interactive log in

Can be overridden programmaticallyCan be overridden programmatically
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LKG CapabilitiesLKG Capabilities

Restores bootable configuration when:Restores bootable configuration when:
A new driver was installed since the last successful A new driver was installed since the last successful 
bootboot

A driverA driver’’s settings were modified since the last s settings were modified since the last 
successful bootsuccessful boot

System settings were modified since the last System settings were modified since the last 
successful bootsuccessful boot
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LKG LimitationsLKG Limitations

DoesnDoesn’’t work if:t work if:
An existing driver was updatedAn existing driver was updated

A latent driver bug for some reason becomes activeA latent driver bug for some reason becomes active

Files or registry hives are missing or corruptFiles or registry hives are missing or corrupt
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Leveraging the Failed Control SetLeveraging the Failed Control Set

When you use LKG the control set you avoid is saved When you use LKG the control set you avoid is saved 
as the Failed control setas the Failed control set

1.1. Look at the Failed value in the Select key Look at the Failed value in the Select key –– this is the control this is the control 
set that you abortedset that you aborted

2.2. Export the current control set and failed control set to .Export the current control set and failed control set to .regreg
filesfiles

3.3. Massage the text so that there are no differences in the Massage the text so that there are no differences in the 
control set namecontrol set name

4.4. WindiffWindiff or or FcFc to see whatto see what’’s differents different
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Safe Mode DescriptionSafe Mode Description
Try Safe Mode if LKG doesnTry Safe Mode if LKG doesn’’t workt work

Accessible from same boot menu as LKGAccessible from same boot menu as LKG

Idea is to only include core set of Idea is to only include core set of 
drivers/servicesdrivers/services

Modeled after Safe Mode in Windows 95Modeled after Safe Mode in Windows 95

Avoids thirdAvoids third--party and unnecessary drivers, which party and unnecessary drivers, which 
hopefully are whathopefully are what’’s causing the boot problems causing the boot problem
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Safe Mode DescriptionSafe Mode Description

HKLMHKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\SafebootSafeboot guides safe guides safe 
mode by specifying names and groups of driversmode by specifying names and groups of drivers

Normal, Network, CommandNormal, Network, Command--PromptPrompt
No networking in NormalNo networking in Normal
Networking includes networking servicesNetworking includes networking services
CommandCommand--Prompt is same as Normal except launches Prompt is same as Normal except launches 
Command Prompt instead of Explorer as shell for when Explorer Command Prompt instead of Explorer as shell for when Explorer 
shell extensions cause logon problemsshell extensions cause logon problems

Directory Services Restore Mode: not for boot troubleshooting Directory Services Restore Mode: not for boot troubleshooting 
(for repairing or restoring Active Directory database from (for repairing or restoring Active Directory database from 
backup)backup)
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Safe Mode InternalsSafe Mode Internals
Registry keys guide whatRegistry keys guide what’’s in safe modes:s in safe modes:

HKLMHKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\SafeBootSafeBoot\\MinimalMinimal is for is for 
Normal and CommandNormal and Command--PromptPrompt

HKLMHKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\SafeBootSafeBoot\\AlternateShellAlternateShell
specifies shell for Commandspecifies shell for Command--Prompt bootPrompt boot

HKLMHKLM\\SystemSystem\\CurrentControlSetCurrentControlSet\\SafeBootSafeBoot\\NetworkNetwork is for is for 
NetworkNetwork
Drivers and services must be listed by name or by group to be Drivers and services must be listed by name or by group to be 
loadedloaded

Exception: all bootException: all boot--start drivers load regardless!start drivers load regardless!
System assumes they are necessary to bootSystem assumes they are necessary to boot
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Using Safe ModeUsing Safe Mode

If Safe Mode works determine whatIf Safe Mode works determine what’’s wrong:s wrong:
Compare boot logsCompare boot logs
Analyze a crash dump (covered in the next section)Analyze a crash dump (covered in the next section)

Boot logging:Boot logging:
Select it from same menu as LKG and Safe Mode Select it from same menu as LKG and Safe Mode 
and boot to the failureand boot to the failure

Saves log in Saves log in \\WindowsWindows\\Ntbtlog.txtNtbtlog.txt

Reboot in Safe ModeReboot in Safe Mode
Safe Mode appends to the boot logSafe Mode appends to the boot log

Extract failed boot and Safe Mode entries to Extract failed boot and Safe Mode entries to 
separate files, strip separate files, strip ““Did not load driverDid not load driver”” lines and lines and 
compare e.g. compare e.g. WindiffWindiff, , fcfc
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Resolving the Faulty Driver IssueResolving the Faulty Driver Issue

If you can determine what driver is causing the If you can determine what driver is causing the 
problem:problem:

Roll back to a previous version if one is available Roll back to a previous version if one is available 
and known to be stableand known to be stable
oror

Disable it with Device ManagerDisable it with Device Manager
Note: canNote: can’’t do this for nont do this for non--PnP drivers: use the registry PnP drivers: use the registry 
editoreditor
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When Safe Mode FailsWhen Safe Mode Fails

Symptom:Symptom:
Safe mode crashes the same as a normal bootSafe mode crashes the same as a normal boot

Causes:Causes:
The driver causing the crash also loads in safe The driver causing the crash also loads in safe 
modemode

Troubleshooting:Troubleshooting:
Determine the problematic driver:Determine the problematic driver:

Boot into RC and look at the last line in the boot logBoot into RC and look at the last line in the boot log
Or, boot into debugging mode and analyze crashOr, boot into debugging mode and analyze crash

Disable it with the RCDisable it with the RC’’s s ““disabledisable”” commandcommand
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The End!The End!

Thank you for comingThank you for coming

For more information, see Windows Internals, 4For more information, see Windows Internals, 4thth

editionedition

Questions: send to Questions: send to daves@solsem.comdaves@solsem.com


